
OptiFiber
Technical Documentation

Optical Fiber Design Software

Version 2.1
for Windows® 2000/XP/Vista/XP 64/Vista 64TM





OptiFiber
Technical Documentation
Optical Fiber Design Software
Copyright © 2007 Optiwave
All rights reserved.

All OptiFiber documents, including this one, and the information contained therein, is copyright material.

No part of this document may be reproduced, stored in a retrieval system, or transmitted in any form or by any means whatsoever, 
including recording, photocopying, or faxing, without prior written approval of Optiwave.

Disclaimer
Optiwave makes no representation or warranty with respect to the adequacy of this documentation or the programs which it 
describes for any particular purpose or with respect to its adequacy to produce any particular result. In no event shall Optiwave, its 
employees, its contractors or the authors of this documentation, be liable for special, direct, indirect, or consequential damages, 
losses, costs, charges, claims, demands, or claim for lost profits, fees, or expenses of any nature or kind.



Technical support

If you purchased Optiwave software from a distributor that is not listed here, please send technical 
questions to your distributor.

Optiwave Systems Inc.
Tel (613) 224-4700 E-mail support@optiwave.com

Fax (613) 224-4706 URL www.optiwave.com

Cybernet Systems Co., Ltd. Japan
Tel +81 (03) 5978-5414 E-mail owtech@cybernet.co.jp

Fax +81 (03) 5978-6082 URL www.cybernet.co.jp

Optiwave Europe Europe
Tel +33 (0) 494 08 27 97 E-mail support@optiwave.com

Fax +33 (0) 494 33 65 76 URL www.optiwave.eu

http://www.optiwave.eu

mailto:support@optiwave.com
http://www.cybernet.co.jp
mailto:owtech@cybernet.co.jp
http://www.optiwave.com
mailto:support@optiwave.com



Table of Contents

Table of Contents............................................................................................. 1

Introduction to OptiFiber................................................................................. 1
Welcome .................................................................................................................... 1

What is OptiFiber? ............................................................................................................1
With OptiFiber the user can: .............................................................................................1
What is new in OptiFiber version 2.0 ................................................................................2
What is new in OptiFiber 2.1 ............................................................................................3

Installation........................................................................................................ 5
Hardware requirements ....................................................................................................5
Software requirements .....................................................................................................5
Installation procedure .......................................................................................................5
Documentation .................................................................................................................5
Online Help.......................................................................................................................6
Support .............................................................................................................................6

Getting Started with OptiFiber........................................................................ 7
Learning Basic Features of OptiFiber ..................................................................... 7

Starting and exiting OptiFiber ...........................................................................................7
Looking at OptiFiber interface ..........................................................................................7
Using menu commands....................................................................................................7
Using Standard toolbar commands ..................................................................................8
Using Graph Tools toolbar commands .............................................................................8
Using Navigator pane .....................................................................................................10
Using Views window.......................................................................................................12
Managing projects ..........................................................................................................13

Designing and Calculating with OptiFiber................................................... 15
Designing a fiber profile ..................................................................................................15
Calculating fiber modes ..................................................................................................18
Calculating properties of fundamental mode ..................................................................19
Calculating properties of higher order mode...................................................................27
Calculating properties of an arbitrarily selected group of modes....................................28
Calculating cutoff wavelengths .......................................................................................30
Calculating birefringence ................................................................................................32
Calculating polarization mode dispersion .......................................................................33



Using Graph Tools......................................................................................... 35
Using “Joints” tool ...........................................................................................................35
Using “Zoom” tools .........................................................................................................37
Using “Measure” tool ......................................................................................................39
Using “Tracking” tool ......................................................................................................40
Using “Legend” tool ........................................................................................................40

Technical Background .................................................................................. 41
Refractive Index of Fibers ...................................................................................... 41

Host materials.................................................................................................................41
Dopant materials ............................................................................................................41
Index profile of fibers ......................................................................................................41
Two techniques for defining the refractive index profile..................................................44

Fiber Propagation Modes ....................................................................................... 45
Scalar fiber modes..........................................................................................................45
Vector fiber modes .........................................................................................................45

Group Delay and Dispersion Definitions .............................................................. 46
Material dispersion of the bulk glasses...........................................................................46
Material dispersion of the fiber .......................................................................................46
Waveguide dispersion of the fiber ..................................................................................47
Total dispersion of the fiber ............................................................................................47

Mode Field Diameter and Mode Area Definitions................................................. 48
Mode field diameter and area importance ......................................................................48
Near-field diameter definition..........................................................................................48
Far-field diameter definition ............................................................................................48
Effective mode area definition ........................................................................................49
Effective diameter definition ...........................................................................................49

Cutoff Wavelengths ................................................................................................ 50
A “Theoretical” cutoff value.............................................................................................50
An “Estimated ITU-T” cutoff value ..................................................................................50

Fiber Loss Models................................................................................................... 51
Fiber propagation loss definition.....................................................................................51
Rayleigh scattering model ..............................................................................................51
Ultraviolet absorption model ...........................................................................................51
OH-radical absorption model ..........................................................................................52
Infrared absorption model...............................................................................................53
Macrobending loss model...............................................................................................53
Microbending loss model ................................................................................................55
Splice loss model............................................................................................................55

Fiber Birefringence Models.................................................................................... 58
Fiber birefringence definition ..........................................................................................58
Intrinsic perturbations birefringence ...............................................................................58



Elliptical core birefringence definition .............................................................................58
Internal stress birefringence definition............................................................................60
Extrinsic perturbations birefringence ..............................................................................62
Lateral stress birefringence definition .............................................................................62
Bending birefringence definition .....................................................................................62
Bending under tension birefringence definition ..............................................................63

Polarization Mode Dispersion Models .................................................................. 65
Polarization mode dispersion .........................................................................................65
Principal states of polarization........................................................................................65
Dispersion vector definition ............................................................................................65
Poincaré sphere .............................................................................................................66
Ensemble simulation ......................................................................................................66
Spectral simulation .........................................................................................................66
First order dispersion definition ......................................................................................66
Second order dispersion definition .................................................................................68
Effective Nonlinear Refractive Index ..............................................................................69
Interference (speckle) patterns (linear superposition/composition of modal fields) ........69
Coupling efficiencies (linear decomposition of an input beam).......................................69
Scanning.........................................................................................................................70
Compatibility with the NR-9200 Optical Fiber Analyzer from EXFO Inc. ........................70

Technical References ............................................................................................. 72

Tutorial Lessons ............................................................................................ 75
Lesson 1: Designing Single Mode Fiber ............................................................... 75

Defining fiber profile........................................................................................................75
Defining dispersion models ............................................................................................76
Calculating fiber modes ..................................................................................................78
Calculating cutoff wavelength.........................................................................................79
Calculating properties of fundamental mode ..................................................................79
Viewing results ...............................................................................................................80
Simulating polarization mode dispersion ........................................................................80
Performance Characterization........................................................................................83

Lesson 2: Characterizing A Real Fiber Sample.................................................... 85
Experimental procedures................................................................................................85
Importing the experimental profile ..................................................................................86
Calculating the parameters of the fiber sample ..............................................................89

Lesson 3: Designing Dispersion Shifted Fiber .................................................... 92
Defining fiber profile........................................................................................................92
Finding the zero dispersion wavelength .........................................................................94
Optimizing profile for a required zero dispersion wavelength .........................................95

Lesson 4: Designing Dispersion Flattened Fiber................................................. 98
Defining fiber profile........................................................................................................98
Calculating the characteristics of the dispersion flattened fiber....................................100



Commands Reference................................................................................. 103
File Menu Commands ........................................................................................... 103

New command..............................................................................................................103
Open command ............................................................................................................103
Close command............................................................................................................103
Save command.............................................................................................................103
Save As ........................................................................................................................103
Export Profile command ...............................................................................................104
Import Profile command ...............................................................................................104
Print command .............................................................................................................104
Print Preview command................................................................................................104
Print Setup command ...................................................................................................104
Recent Files command.................................................................................................105
Exit command...............................................................................................................105

View Menu Commands ......................................................................................... 105
Status Bar .....................................................................................................................105
Navigator command .....................................................................................................105
Toolbars command.......................................................................................................105
Views command ...........................................................................................................105

Fiber Menu Commands ........................................................................................ 106
Profile command...........................................................................................................106

Simulation Menu Commands............................................................................... 106
Modes command ..........................................................................................................106
Fundamental Mode command......................................................................................107
Higher Order Modes command ....................................................................................107
Cutoff command ...........................................................................................................107
Birefringence command................................................................................................108
PMD command.............................................................................................................108

Tools Menu Commands........................................................................................ 108
Settings command........................................................................................................108
Table command............................................................................................................109
Calculated results command ........................................................................................109

Window Menu Commands ................................................................................... 109
New Window command................................................................................................109
Cascade command.......................................................................................................109
Tile command ...............................................................................................................109
Arrange Icons command ..............................................................................................109
List of Windows command............................................................................................110

Graph Tools Commands ...................................................................................... 110
“Joints” command .........................................................................................................110
“Zoom XY” command ...................................................................................................111



“Zoom X” command......................................................................................................113
“Zoom Off” command ...................................................................................................113
“Measure” distance command ......................................................................................113
“Tracking” command.....................................................................................................115
“Legend” command ......................................................................................................116
“Grid X” command ........................................................................................................117
“Grid Y” command ........................................................................................................118
“X Cut” command .........................................................................................................119
“Y Cut” command .........................................................................................................120

Dialog Boxes Reference ....................................................................................... 122
Fiber Profile Related Dialogs ............................................................................... 122

Select Profile Type dialog box ......................................................................................122
Fiber Profile dialog box.................................................................................................122
Info dialog box ..............................................................................................................127
Material Properties dialog box ......................................................................................128
Parameters of Material dialog box................................................................................132
Profile Function Parameters dialog box........................................................................134
Gaussian Function Parameters dialog box...................................................................135
Parabolic Layer Parameters .........................................................................................136
Alpha Power Law Function Parameters dialog box......................................................137
User Defined Function dialog box ................................................................................138
Refractive index profile preconditioning dialog .............................................................143

Fiber Modes Related Dialogs ............................................................................... 145
Modes dialog box .........................................................................................................145
Composition dialog box ................................................................................................147
Linear decomposition of a given field distribution .........................................................149
Properties of Fundamental Mode dialog box................................................................151
Properties of Higher Order Modes dialog box ..............................................................154
Cutoff dialog box...........................................................................................................155

Fiber Loss Related Dialogs .................................................................................. 158
Material Loss dialog box...............................................................................................158
IR Absorption dialog box ..............................................................................................160
UV Absorption dialog box .............................................................................................161
Rayleigh Scattering dialog box .....................................................................................162
Bending Loss dialog box ..............................................................................................164
Splice Loss dialog box..................................................................................................165

Fiber Birefringence Related Dialogs ................................................................... 167
Birefringence dialog box ...............................................................................................167

Polarization Mode Dispersion Related Dialogs.................................................. 170
Polarization Mode Dispersion dialog box......................................................................170
PMD dialog box ............................................................................................................172

Graph Related Dialogs.......................................................................................... 173
Table dialog box ...........................................................................................................173



Calculated results dialog box........................................................................................174
Graphic Properties dialog box ......................................................................................176

Settings .................................................................................................................. 179
Global Settings dialog box............................................................................................179

Output Views Reference....................................................................................... 181
Profile view ...................................................................................................................181
Modal Index view..........................................................................................................181
Group Delay view .........................................................................................................182
Dispersion view ............................................................................................................184
Mode Measures view....................................................................................................184
Material Loss view ........................................................................................................185
Bending Loss view........................................................................................................187
Splice Loss view ...........................................................................................................187
Mode Field view............................................................................................................188
Birefringence view ........................................................................................................190
PMD view .....................................................................................................................191
Effective Nonlinear Refr. Index view.............................................................................192

Appendix A - Script Language Reference ................................................. 195
Overview of Script Language............................................................................... 195
Variables, Arrays, and Operators ........................................................................ 195

Variables.......................................................................................................................195
Arrays ...........................................................................................................................195
Mathematical Operators ...............................................................................................196
Boolean operators ........................................................................................................196
Comparison operators ..................................................................................................196

Commands and Statements................................................................................. 197
Commands and statements..........................................................................................197
RETURN command......................................................................................................197
IF statement..................................................................................................................198
ERROR keyword ..........................................................................................................199
FIRSTTIME keyword ....................................................................................................200
Input dialog box ............................................................................................................200
Example Input...............................................................................................................200
Example Ginput ............................................................................................................201

Predefined Constants.................................................................................. 203
Mathematical constants ................................................................................................203
Physical constants ........................................................................................................203

Functions Library.................................................................................................. 204
Commonly used functions ............................................................................................204



Other functions .............................................................................................................204
Fresnel integral .............................................................................................................205
Gamma function ...........................................................................................................205
Error function ................................................................................................................206
Bessel functions ...........................................................................................................207

Unit Conversions .................................................................................................. 209
Length conversions ......................................................................................................209
Temperature conversions.............................................................................................209
Other conversions ........................................................................................................209

Appendix B - Fiber Mode Solvers............................................................... 211
Introduction ........................................................................................................... 211
Real-valued formulation ....................................................................................... 212
Debye Potential ..................................................................................................... 212
Separation of Variables ........................................................................................ 214
Solution of the linear system ............................................................................... 215
Dispersion equation.............................................................................................. 216
LP Modes ............................................................................................................... 218
References............................................................................................................. 220

Appendix C - Opti2D Graph Control........................................................... 221

Appendix D - File Formats .......................................................................... 241





  INTRODUCTION TO OPTIFIBER
Introduction to OptiFiber

Welcome

What is OptiFiber?
Telecommunications using fibers as the transmission media is now a major industry. 
Choosing appropriate fiber parameters is an important issue for a given optical 
system. Cross-sectional dimensions, material composition, and refractive index 
profile all influence the losses, dispersion and the nonlinearities of the fiber and must 
be chosen carefully to achieve a satisfactory tradeoff for a given application.

All these parameters of existing fiber samples could be experimentally measured and 
then the fiber manufacturing process adjusted towards an optimized production. 
However, this trial and error approach is extremely slow, expensive and unreliable. 
Moreover, some important fiber parameters, for example the total group-velocity 
dispersion and the effective nonlinear coefficient, are not directly measurable with 
compact tabletop devices. Because of that, the number of professionals who use an 
appropriate fiber design and modeling software is growing constantly across the 
photonics industry.

OptiFiber is the leading commercial product in that category. It is a powerful tool that 
blends numerical mode solvers for fiber modes with calculation models for group 
delay, group-velocity dispersion, effective mode area, losses, polarization mode 
dispersion, effective nonlinearity, etc. Among the most powerful features of OptiFiber 
are its abilities to predict how any given fiber could be optimized versus a design goal, 
for example small, but non-zero dispersion and maximal mode area. In addition, 
OptiFiber can supplement and extend the fiber characterization capabilities of real 
laboratory devices, such as EXFO’s NR-9200 Optical Fiber Analyzer, by importing 
and analyzing the refractive index profiles of real fiber samples. OptiFiber is an 
indispensable tool for engineers, scientists and students who design fibers, fiber 
components and optical communications systems.

With OptiFiber the user can:
• Design a multilayer fiber with an arbitrary 2D refractive index profile by either:

• Defining the profile internally, using a library of built-in functions or a using a 
user-specified formula

• Importing an external profile (directly supports profiles scanned with NR-
9200)

• Assign material dispersion based on Sellmeier model or user-defined functions
• Model material losses based on known experimental formulas
• Calculate the following characteristics of any supported mode, fundamental or 

higher order:
• Mode field pattern, displayed in a number of ways
• Effective refractive index and the propagation constant
1
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• Group delay
• Three types of group-velocity dispersion (material, waveguide, total)
• Mode field diameters according to various definitions and eff. mode area
• Estimations of the cutoff wavelengths
• Macrobending, microbending and splicing losses

• Optimize the dependence of these characteristics on numerous technological 
parameters of the fiber:

• geometry, profile shape, composition.
• Calculate and visually compare the parameters of an arbitrary group of modes vs. 

the mode number
• Calculate birefringence effects induced by intrinsic or extrinsic perturbations
• Estimate the PMD based on stochastic model
• Use two alternative ways of defining the profile of the fiber:

• As a refractive index profile.
• As a dopant concentration profile.

• Access the models:
• Macrobending losses of higher order modes.
• Estimations of the cutoff wavelength as given by the ITU-T recommended 

experimental
• procedure.
• Effective mode area.
• Effective nonlinear refractive indices of arbitrary mode as determined by the 

nonlinear indices of
• the bulk materials and on the waveguiding properties of the fiber: shape of 

mode pattern, degree of
• confinement, etc.

• Access a rich material library
• Try the examples.
• Use experimental profiles of real fiber samples scanned with NR-9200 from 

EXFO Inc.

What is new in OptiFiber version 2.0
Meshless mode solvers for LP and vector modes. As with the original mode solver 
of OptiFiber, the fibers can consist of an arbitrary number of concentric layers of 
lossless materials, and graded index fibers can be approximated using a sequence of 
constant index layers. The new mode solvers are different from the original one in that 
they do not use meshes to approximate the structure. Instead, they find an exact 
solution based on matching boundary conditions at layer boundaries. These mode 
solvers should be especially useful for multimode fiber calculations, where there are 
many modes in the spectrum. Another advantage of the meshless mode solver is the 
calculation of fields far from the fiber. Meshing introduces finite difference errors of a 
certain level, and fields weaker than the differencing error cannot be calculated. The
2



  INTRODUCTION TO OPTIFIBER
meshless mode solvers, on the other hand, have the correct asymptotic behavior far 
from the fiber, and can calculate fields of magnitude  or less. In OptiFiber 
version 2.0, the desired mode solver is selected by radio button in the Modes dialog 
box.

Propagation over distance feature. OptiFiber allows users to decompose an 
arbitrary field into the modes of a multimode fiber. It calculates the complex 
coefficients of the modes for the arbitrary field. Similarly, given the amplitude of a set 
of modes, OptiFiber can display the sum (composition of modes). OptiFiber 2.0 can 
also calculate this multimode field after propagating down the fiber by a specified 
distance. The user enters a distance. Each of the complex coefficients of the modes 
is multiplied by the appropriate phase factor, and the new field pattern is displayed in 
the preview box.

What is new in OptiFiber 2.1
In OptiFiber 2.1, four enhancements were introduced to the user interface.  The first 
two enhancements, radius specified instead of layer widths, and  layer index specified 
relative to cladding, are implemented in a Settings dialog box to customize data entry 
and display according to user preference.  The parabolic function layer was enhanced 
with an option to reverse the sense of direction, and it is now possible to export the 
data found in the Cutoff dialog box.

Radius specified instead of layer widths.  In OptiFiber, the fiber profile is specified 
as a list of Regions (layers) of various widths.  There is a read only field to show the 
position (radius) of the selected layer.  It is now possible to enter the radius of the layer 
instead of the layer width.  In this option, the width field will become read only instead 
of the position field.

Layer index specified relative to cladding. In the Fiber Profile dialog box, the 
refractive index of the selected layer is displayed in the Refractive Index field.   It is 
now possible to specify the refractive index relative to the cladding layer instead.  With 
this option, when the last layer is selected, the cladding refractive index will be 
displayed in the Refractive Index field.  However, when other layers are selected, the 
index of current layer relative to the cladding layer will be shown.  Data entry is also 
relative.

Export Cutoff data.  An option to export this data to a text file has been added.

Parabolic function layer can go both ways.  The parabolic layer has its extreme 
value on the left side of the layer by default.  Now the layer can have the extreme 
value on the right side as well.

10 15–
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 INSTALLATION
Installation

Hardware requirements
OptiFiber requires the following system configuration:
• Personal computer with the Pentium processor
• 10 MB free hard disk space
• 32 MB of RAM recommended
• Graphic resolution of 1024 x 768, minimum 256 colors

Software requirements
OptiFiber requires one of the following operating systems:
• Microsoft Windows 2000
• Microsoft Windows XP

Installation procedure
To install OptiFiber on Windows 2000/XP:

1. Log on as the Administrator or on an account with Administrator privileges.
2. Insert the OptiFiber CD into your CD ROM drive.
3. Press the Start button and select Run.
4. In the Run dialog box, type 'F:\setup.exe,' where 'F' denotes your CD ROM 
drive.
5. Click the OK button and follow the screen instructions and prompts.
6. Reboot the computer.

Documentation
You can quickly become an efficient OptiFiber user by reading carefully and referring 
to the technical documentation OptiFiber provides.

OptiFiber is shipped with documentation that consists of the following sections:
• Introduction to OptiFiber
• Getting Started with OptiFiber
• Technical Background
• Tutorial Lessons
• Commands Reference
• Dialog Boxes Reference
• Output Views Reference
• Script Language
5



 INSTALLATION
The Help system contains references and tips that do not exist elsewhere. You can 
easily search topics by using the Help system.

Online Help
OptiFiber online Help follows standard rules of Help design and usage. If you are 
familiar with the Help of your computer operation system, then you will quickly learn 
how to get the most from OptiFiber Help by following similar steps. The OptiFiber Help 
is organized in topics that follow the logic of a printed book. However, cross-
references and jumps allow you to quickly find required information. Since OptiFiber 
dialog boxes usually contain complicated technical information, we described all of 
them in the Dialog Box Reference that forms a part of the Help system.

Support

Technical support

Optiwave provides technical support for all users of OptiFiber. The technical support 
includes:

Technical Support by Phone

Highly qualified Optiwave representatives are available for telephone assistance 
Monday to Friday, 8:30 a.m. to 5:00 p.m. Eastern Standard Time. Tel: (613) 224-
4700.

Technical Support by Fax

To get technical assistance, you can also send a fax, and you will receive assistance 
to overcome whatever problems you may have. Fax: (613) 224-4706.

Technical Support by E-mail

You can also send e-mail to support@optiwave.com.

Using Optiwave’s Web Page

For additional information, you can use the Optiwave web page. From the Help menu, 
click About OptiFiber and click www.optiwave.com.
6
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 GETTING STARTED WITH OPTIFIBER
Getting Started with OptiFiber

Learning Basic Features of OptiFiber

Starting and exiting OptiFiber
When you start the OptiFiber program, an empty workspace appears on the screen.

Use one of the following methods to open a project file:
• Select “New” from the “File” menu or double-click on the workspace for a new 

OptiFiber project
• Select “Open”, then browse to an existing OptiFiber file to open a previously 

saved project
• Select one of the recently opened files at the bottom of the File menu to open it

To exit OptiFiber:
• Select “Exit” from the “File” menu

The program will prompt you to save project files that were changed.

Looking at OptiFiber interface
The OptiFiber user interface is designed to provide you easy access to the frequently 
used commands.

After opening a new project file, you can see the OptiFiber workspace window 
containing the following elements:
• Main Menu bar with menus: File, View, Fiber, Simulation, Tools, Window, and 

Help
• Toolbars: Standard and Graph Tools
• Navigator pane with icons: Fiber Profile, Modes, Fundamental Mode, Higher 

Order Mode, Cutoff, Birefringence, and PMD
• View window with tabs: Profile, Modal Index, Group Delay, Dispersion, Mode 

Measures, Material Loss, Bending Loss, Splice Loss, Mode Field, Birefringence, 
PMD, Effective Nonlinear RI and Comments

Using menu commands
You can access the commands of OptiFiber using the interface menus. Each of the 
main menus has various command options.

The menu commands are described in the Commands Reference, where first 
sections titles correspond to the main menu options:
• File Menu Commands: New, Open, Close, Save, Save As, Export Profile, Import 

Profile, Print, Print Preview, Print Setup, Recent Files, Exit
• View Menu Commands: Status Bar, Navigator, Toolbars, Views
7
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• Fiber Menu Commands: Profile
• Simulation Menu Commands: Modes, Fundamental Mode, Higher Order Modes, 

Cutoff,Birefringence, PMD
• Tools Menu Commands: Settings, Table, Calculated Results
• Window Menu Commands: New Window, Cascade, Tile, Arrange Icons

Using Standard toolbar commands
The Standard toolbar contains command buttons familiar to Windows users: New, 
Open, Save, Copy, Print, and About.

The Standard toolbar commands are described in the Commands Reference 
sections:
• New Command
• Open Command
• Save Command
• Print Command

Using Graph Tools toolbar commands
The Graph Tools toolbar contains commands frequently used in handling OptiFiber 
graphical views. They include such commands as Joints, Measure Distance, 
Tracking, Zoom X, Zoom XY, Zoom Off, Legend, Grid X, Grid Y, X Cut, and Y Cut.

The Graph Tools toolbar commands are described in the Commands Reference 
sections:
• Joints Command
• Measure Distance Command
• Tracking Command
• Zoom X Command
• Zoom XY Command
• Zoom Off Command
8
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• Legend Command
• Grid X Command
• Grid Y Command
• X Cut Command (Available only in the Mode Field view)
• Y Cut Command (Available only in the Mode Field view)
9
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Using Navigator pane
The Navigator pane provides quick access to the most frequently used commands. It 
contains icons that activate start the main dialog boxes of OptiFiber. These dialog 
boxes are used to enter data and run calculations.
10
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The Navigator options are described in the Commands Reference sections:
• Fiber Profile Command
• Modes Command
• Fundamental Mode Command
• Higher Order Modes Command
• Cutoff Command
• Birefringence Command
• PMD Command
11
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Using Views window
The Views window provides all graphical output from simulations. The graphs appear 
in the view tabs as they are calculated. In a new file, most views are empty, except 
the Material Loss tab, where a default loss characteristic is displayed.

The list of available view tabs is as follows:
• Profile view
• Modal Index view
• Group Delay view
• Dispersion view
• Mode Measures view
• Material Loss view
• Bending Loss view
• Splice Loss view
• Mode Field view
• Birefringence view
• PMD view

Click Material Loss to see the default material loss mechanisms and the total loss vs. 
wavelength.

Later, you will learn how to change these fiber characteristics. The empty view tabs 
will be filled with graphs after execution of relevant simulations.
12
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Views are described in the Output Views Reference beginning with the Profile View 
section.

Managing projects
You can open and work with many projects files using the same OptiFiber workspace. 
Different output view windows represent the project files. OptiFiber generates default 
titles to newly opened files, for example Fiber 1, Fiber 2, etc. It is convenient to tile 
several projects for the purpose of comparison.

The simulation commands always refer to the active view window.
13
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  DESIGNING AND CALCULATING WITH OPTIFIBER
Designing and Calculating with OptiFiber

Designing a fiber profile
The process of designing a new fiber usually starts by defining its profile. Click the 
“Fiber Profile” icon in the Navigator pane or double-click the workspace or select the 
“Fiber/Profile” menu item.

Currently two types of profiles are supported: refractive index profile and dopant 
concentration profile. The “Select Profile Type” dialog box offers a choice between 
them.

After that the “Fiber Profile” dialog box appears. In case the user has selected 
refractive index profile type, it looks as shown:
15
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To create a simple step-index fiber (similar to SMF-28) do the following steps:

Step Action 
1 In the “Fiber Profile” dialog box, click the “Add” button twice to create two 

radial index regions: “Region 0” and “Region 1”. These two regions will 
represent the fiber core and cladding, respectively.

2 Select “Region 0” on the list and enter its Width value 4.15 microns, then 
select the “Profile” option as “Constant”, and enter the “Refr. Index” value 
1.45213.

3 Press “Apply”.

4 Select “Region 1” on the list and enter its “Width” value 58.35, then select the 
“Profile” option “Constant”, and enter the “Refr. Index” value 1.44692.

5 Press “Apply”.

6 Enter the “Wavelength” value 1.3.

7 Press “Apply”.

8 Press “OK” to close the “Fiber Profile” dialog box.

You just designed a simple fiber profile that is shown at in the graph pane at the 
bottom of the dialog box. The fiber profile is defined at the wavelength 1.3 microns.
16
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If in “Select Profile Type” dialog box the user has selected “dopant concentration type” 
then the ‘Fiber Profile” dialog box looks as shown:

The difference from the previous case is that now the user enters the values of the 
molar concentration percentage of the dopant in the edit box where the refr. index 
values were entered. This dialog box contains also an additional group of controls - 
“Display” - allowing viewing of the profile as a refr. index or concentration type one, 
and to color-code the regions. The latter feature is useful for distinguishing 
neighboring regions: 1) having equal refr. indices but doped with different 
concentrations of different materials, or 2) doped with equal concentrations of 
different materials, thus having different refr. indices. The fiber shown in the picture 
above is equivalent to the one in the previous picture.
17
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Calculating fiber modes
After having defined the fiber profile the user can proceed with the calculations. Click 
the “Modes” icon in the “Navigator” pane. The “Modes” dialog box appears.

To recalculate this example fiber profile do the following steps:

Step Action 
1 In the Mode Solver panel, check the LP Modes (finite difference method) 

option and leave the Order “From”, “To”, and “Max” entries with their default 
values.

2 Press the “Recalculate” button.

The program calculates guided LP modes of the fiber. In this example, the fiber is 
multimode, with the effective index of the fundamental mode, 1.4497657, listed along 
the mode name LP (0,1). A graph located to the right of the mode list provides you a 
small quick preview of the field pattern of the selected mode. It is handy in the case 
of fibers supporting multiple modes at the given wavelength, as shown below:
18



  DESIGNING AND CALCULATING WITH OPTIFIBER
Calculating properties of fundamental mode
Click the “Scan Fundamental Mode” icon in the Navigator pane. The “Properties of 
Fundamental Mode” dialog box appears.
19



 DESIGNING AND CALCULATING WITH OPTIFIBER
Do the following steps:

Step Action 
1 Press the “Calculate” button. The routines calculate all characteristics 

checked in the Calculate section. In the “Views” window, you can now see 
graphs of these characteristics.

2 Click the “Modal Index” tab to see the plot of the effective refractive index 
versus wavelength

3 Click the “Group Delay” tab to see the plot of the group delay versus 
wavelength:
20
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4 Click the “Dispersion” tab to see the plot of the group delay versus 
wavelength:
21
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5 Click the “Mode Measures” tab to see the plot of the mode field diameters 
versus wavelength:
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  DESIGNING AND CALCULATING WITH OPTIFIBER
6 Click the “Bending Loss” tab to see the plot of the micro- and macrobending 
loss versus wavelength:
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 DESIGNING AND CALCULATING WITH OPTIFIBER
7 Click the “Splice Loss” tab to see the plot of splice loss versus wavelength:
24



  DESIGNING AND CALCULATING WITH OPTIFIBER
8 Click the “Mode Field tab” to see the plot of the LP(0,1) mode field versus 
transverse dimensions of the fiber:
25
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9 Click the “Eff. Nonlinear RI” to see the plot of this parameter. Its definition is 
given in the “Technical Background“ section
26



  DESIGNING AND CALCULATING WITH OPTIFIBER
Calculating properties of higher order mode
If the current fiber design supports multiple modes their characteristics can be 
calculated the following way:

Step Action 
1 In the “Modes” dialog box recalculate and select the higher-order mode of 

interest. In that example of a typical 65/125 multi-mode graded-index fiber it 
is LP(3,6)

Click the “High Order Mode” icon in the Navigator pane. The “Properties of High Order 
Mode” dialog box appears.
27



 DESIGNING AND CALCULATING WITH OPTIFIBER
It offers the choices to calculate (scan) the characteristics of the selected mode vs. 
the wavelength, the proportionally reduced/expanded profile width, etc. After the 
calculation the results are displayed in the same view tabs described above.

Calculating properties of an arbitrarily selected group of modes
If the current fiber design supports multiple modes the characteristics of a group of 
modes can be calculated for comparison:

Step Action 
1 In the “Modes” dialog box recalculate and select the group of modes, in this 

case all the modes from LP(0,1) to LP(2,6)

2 Then proceed to the “Properties of High Order Mode”. Its left-side controls are 
now disabled and the “Multiple Mode Scan” is checked as the parameter of 
this calculation is the mode itself, instead of some technological figure of the 
fiber.
28



  DESIGNING AND CALCULATING WITH OPTIFIBER
The user can also choose to sort the results according to the initial sequential number 
of the mode in the selected group…

…or according to the effective refractive index in descending order.
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Calculating cutoff wavelengths
Click the “Cutoff” icon in the “Navigator” pane. The “Cutoff” dialog box appears. Press 
“Recalculate” first to obtain the mode list. If the fiber is single-mode, reduce the 
wavelength value using the edit box with the same name (to 0.5 microns in the picture 
below).

Two types of cutoff calculations are currently supported and respectively two values 
are displayed for each selected mode:

Step Action 
1 “Theoretical” cutoff values: the wavelength above which the given mode 

cannot propagate even in short regular samples of this fiber.

2 “Estimated ITU-T” cutoff values: these values are obtained by emulating the 
actual experimental cutoff measurements, as described in the ITU-T / TIA / 
EIA recommendations (see [ITU-T] in the Technical references).

After pressing the “Calc. Cutoff” button all cutoff wavelength values are displayed, 
except for the fundamental mode, where the cutoff does not apply. The values shown 
here correspond to a fiber similar to the popular SMF-28.
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 DESIGNING AND CALCULATING WITH OPTIFIBER
Calculating birefringence
Click the “Birefringence” icon in the “Navigator” pane. The “Birefringence” dialog box 
appears.

Step Action 
1 In the “Birefringence” dialog box, check the “Induced by Perturbation 

Parameters” option. The “Photoelastic Constants” entries become available.

2 In the “Photoelastic Constants” section, enter: Young Modulus 7750000000, 
C 3.44e-011, Poisson Ratio 0.164.

3 In the “Induced by Perturbation” Parameters section, check “Extrinsic”, 
“Bending”, and “Fiber Spooled With Tension”.

4 Enter the “Bending” value 0.12

5 Enter the “Fiber Spooled with Tension” value 0.5.

6 In the “Output” section, enter “Spectral Range” 0.4 and “Number of Steps” 51.
32
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7 Press OK to close the “Birefringence” dialog box

8 Go to the “Birefringence” view tab. The birefringence and Differential Group 
Delay (DGD) vs. wavelength are plotted there.

Your “Birefringence” view tab should look like this:

The results can now verified by selecting the “Birefringence” tab on the “Views” 
window:

Calculating polarization mode dispersion
Click the “PMD” icon in the “Navigator” pane. The “Polarization Mode Dispersion” 
dialog box appears. 

To execute the polarization mode dispersion calculations, leave the defaults and 
press “OK”. 

The program calculates the polarization mode dispersion and updates the “PMD” tab 
in the “Views” window.
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The “PMD” dialog box appears automatically showing numerical values related to the 
first two orders of the polarization mode dispersion. These are statistical values and 
can be different on your display.
34



 USING GRAPH TOOLS
Using Graph Tools

Using “Joints” tool
The “Joints” tool shows the actual calculated points of a curve.

Do the following steps:

Step Action 
1 Select a tab in the “Views” window, for example the “Modal Index” tab.

2 Press the “Joints” button on the “Graph Tools” toolbar or, select the “Joints” 
item from the floating context menu, accessible by right clicking in the Views 
windows.
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3 Select “Joints” again to turn it off.
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 USING GRAPH TOOLS
Using “Zoom” tools
“Zoom X”, “Zoom XY” and “Zoom Off” are convenient tools for expanding a portion of 
the graph.

“Zoom X” expands the view only in horizontal direction, “Zoom XY” – in both.

Do the following steps:

Step Action 
1 Select, for example, the “Material Loss” tab in the Views window.

2 Select “Zoom XY” from the “Graph Tools” floating menu or the “Graph Tools” 
toolbar.

3 Now, with the left mouse button, click-and-drag a region to be expanded to a 
full graph. Before releasing the left mouse button, the View tab should look 
like this:

4 Release the left mouse button. The selected part is expanded to the full tab. 
The “View” tab should now look something like this:
37



 USING GRAPH TOOLS
5 Select “Zoom Off “ to restore the default view scale.
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Using “Measure” tool
The “Measure” tool measures the difference between two points of the curve.

Do the following steps:

Step Action 
1 Select, for example, the “Profile” tab in the Views window.

2 Select “Measure” from the “Graph Tools” floating menu or the “Graph Tools” 
toolbar.

3 With the left mouse button, click-and-drag to measure the coordinates' 
difference.

4 Select “Measure” again to turn it off.
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Using “Tracking” tool
The “Tracking” tool shows the XY coordinates of a point of a curve.

Do the following steps:

Step Action 
1 Select the “Group Delay” tab in the Views window.

2 Select “Tracking” from the “Graph Tools” floating menu or the “Graph Tools” 
toolbar.

3 With the left mouse button, click-and-drag to track the coordinates.

4 Select “Tracking” again to turn it off.

Using “Legend” tool
The “Legend” tool shows the short descriptions of the curves in multi-curve graphs. 
Its use is identical to that of the other graph tools. The legend can be dragged, so the 
user can position it anywhere on the “Views” tab.
40
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Technical Background

Refractive Index of Fibers

Host materials
Optical telecommunication-grade fibers are made usually from silica glasses. The 
high purity glass is called the host material or substrate. Its bulk refractive index 
usually defines the refractive index of the fiber cladding. Adding dopant materials to 
the host material forms the fiber core.

Dopant materials
To change the refractive index of optical fiber, pure silica is often doped with dopants. 
For example, adding germanium can result in an increase in the refractive index, 
while adding fluorine reduces it. The refractive index of doped material can be 
determined by the linear relationship between the doped material’s mole percentage 
and permittivity.

Aumme that is the refractive index of the host material and n1 is the refractive index 
of  molepercentage doped material. Then, the refractive index n of m mole-
percentage doped material can be interpolated as:

Index profile of fibers
The radial distribution of the fiber refractive index is called the index profile. That 
profile determines guiding properties of the fiber. In general, the core region has a 
higher index than the cladding region. However, the index profile can have regions 
where the index is lower than the cladding value. Modern fiber designs are based on 
index profiles that assure proper operation within a range of wavelengths. 

For example, a dispersion flattened fiber design involves a couple of concentric index 
regions.

(1)

n0
m1

n2 n0
2 m

m1
------ n1

2 n0
2–( )+=
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In OptiFiber “regions” define a rotationally symmetric fiber profile. In the picture 
above, the fiber profile consists of four regions. Each region has its dimension (width) 
and profile. The default profile options are listed below, where x is the region’s local 
coordinate, w is the width of the region.

Constant profile:

Linear profile:

(2)

(3)

n x( ) const=

n x( ) n 0( ) x n w( ) n 0( )–
w

-----------------------------⋅+=



 TECHNICAL BACKGROUND

43

Parabolic profile:

Exponential profile:

where n(0), n(w) is the refractive index at x = 0 and x = w, respectively.

Gaussian profile:

where  is the maximum value,  is the peak position, and h is the 
normalized value of FWHM.

Alpha –peak profile:

where  is the maximum value,  is normalized difference. It is defined as:

(4)

(5)

(6)

(7)

(8)
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Alpha –dip profile:

where  is the maximum value,  is normalized difference.

Two techniques for defining the refractive index profile
Currently OptiFiber implements two methods for defining the geometry and the 
material composition of the fiber:
• Direct definition of the refractive index profile: the abscissa values n(x) in the 

formulae above are interpreted directly as refractive index values at a user 
specified wavelength. Wherever needed, the dopant concentration in each region 
is internally calculated by interpolating the given value between the refractive 
index values of two materials – “Dopant +” and “Dopant -” and using the formula 
given in “Dopant Materials”. The material dispersion and dispersion of the profile 
are calculated from the known Sellmeier coefficients of “Dopant +” and “Dopant -
”. The parameters of the materials “Dopant +” and “Dopant -” are either taken from 
the internal extendable material library of OptiFiber or user specified. They can 
be different for each region or global for the whole profile. This method is 
convenient whenever the distribution of the refr. index is known from experimental 
measurements, estimations, etc.

• Definition of a dopant concentration profile: the abscissa values n(x) in the 
formulae are interpreted as molar concentration of a certain dopant. The material 
dispersion and dispersion of the profile are calculated from the known Sellmeier 
coefficients of the dopant, which are taken from the internal extendable material 
library of OptiFiber or are user specified.

This method is convenient when the dopant concentration distribution of the fiber or 
at least of its preform are known with sufficient accuracy.

(9)n x( ) nmax 1 2∆– 1 x
w
----– 

  α⋅⋅=

nmax ∆
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Fiber Propagation Modes

Scalar fiber modes
The designation of Linearly Polarized (LP) Fiber modes is based on the assumption 
of weak guidance. Weakly guiding fibers have a small difference between core and 
cladding refractive index.

Two numbers designate the LP (m, n) modes:

m – azimuthal number
n – orbital number where m = 0, 1, 2, … and n = 1, 2…

Both guided and cladding modes of arbitrary circular symmetric refractive index 
profile are calculated either by the accurate finite difference method or by the 
analytical matrix method.

Vector fiber modes
The designation of vector fiber modes TE, TM, EH, and HE follows the convention:

TE (0,n) – transverse electric family of modes
TM (0,n) – transverse magnetic family of modes
EH (m, n) – hybrid family of modes
HE (m, n) – hybrid family of modes
where m and n=1, 2…

See Appendix A, Fiber Mode Solvers by Matrix Method, for details on the LP and 
Vector mode solvers that use the matrix method.
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Group Delay and Dispersion Definitions

Material dispersion of the bulk glasses
If the refractive index of the fiber material varies with wavelength, thus causing the 
group velocity to vary, it is classified as material dispersion.

The group delay  is given by the product of the propagation distance z by the first 
frequency-derivative of the propagation constant:

where n is the refractive index, 

We have:

The dispersion coefficient D is defined as:

In bulk materials, we have:

Material dispersion of the fiber
In a fiber, the materials of core and cladding are different. If there are L layers in the 
fiber cross-section, each layer has different refractive index.

(10)
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The total material dispersion of a fiber is calculated by:

where the confinement factor of each layer is . The confinement factor is the 
portion of total power guided in the i-th layer.

Waveguide dispersion of the fiber
Waveguide dispersion is the result of the wavelength-dependence of the effective 
refractive index  of the fiber mode. First, the mode solver calculates the relation 
between  and wavelength , then the waveguide dispersion is calculated by:

Total dispersion of the fiber
The total dispersion is the total effect of material and waveguide dispersion. It is 
calculated in a similar way as for calculating waveguide dispersion. In this case, the 
fiber refractive index profile depends on the wavelength. The material dispersion 
effect should be calculated first. Then the mode solver calculates the mode effective 
index . The total dispersion of a fiber is:

(14)

(15)
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Mode Field Diameter and Mode Area Definitions

Mode field diameter and area importance
The Mode Field Diameter (MFD) is an important parameter related to the optical field 
distribution in the fiber. It has been shown that MFD provides useful information about 
the cabling performances, such as possible joint, macrobending, and microbending 
losses. The effective area of the fibers has a direct relation to the nonlinear distortions 
in long fiber links. Currently OptiFiber calculates the following spatial measures of the 
modes:

Near-field diameter definition
The near-field Mode Field Diameter (near-field MFD) is also known in the literature as 
the “Petermann I” diameter. It is defined as the diameter at which the near field power 
falls to of its maximum value. It can be calculated by [Artiglia, 1989[2]:

where E(r) is the optical mode field distribution.

Far-field diameter definition
The far-field Mode Field Diameter (far-field MFD) is also known in the literature as the 
“Petermann II” diameter. It is defined as the diameter at which the far field power falls 
to of its maximum value. It can be calculated by [Artiglia, 1989[2]]:

where E(r) is the optical mode field distribution, and prime denotes differentiation of a 
function with respect to its argument.
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Effective mode area definition
The effective Mode Area (eff. MA) is calculated as [see, for example, G. Agrawal, 
1995]

where E(x,y) is the optical mode field distribution.

Effective diameter definition
OptiFiber calculates also the effective Mode Field Diameter (eff. MFD), defined as:

where E(r) is the optical mode field distribution.
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Cutoff Wavelengths
The cutoff wavelength for any mode is defined as the maximum wavelength at which 
that mode will propagate. The cutoff wavelength of is an important 
specification for a single-mode fiber. The operation wavelength must be greater than 
the cutoff wavelength of to operate the fiber in a single mode regime. can be 
determined analytically for some specified fiber profiles. For a general fiber profile, a 
highly accurate numerical mode solver should be involved to calculate cutoff 
wavelength. OptiFiber currently implements two different approaches for finding the 
cutoff and respectively two different values can be calculated for each mode:

A “Theoretical” cutoff value
This is the wavelength, above which the given mode cannot propagate, even in short 
and unperturbed samples of this fiber. This value is calculated using the general 
numerical mode-solvers of OptiFiber. It is defined as the wavelength, above which the 
Eigenvalue problem formulated for the current fiber design and for the given mode 
does not have real solutions.

An “Estimated ITU-T” cutoff value
These values are obtained by emulating the actual experimental cutoff 
measurements, as described in the ITU-T / TIA / EIA recommendations (see [ITU-
T[23]] in the Technical references). It employs a macrobending loss formula [J. Sakai 
and T. Kimura, 1978 [26]] applicable to any mode in arbitrary-index profile optical 
fibers. The ITU-T/EIA-455-80A recommendation is formulated only for the cutoff of 
LP11.

λc LP11

LP11 λc
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Fiber Loss Models

Fiber propagation loss definition
The total fiber loss can be divided into material losses and fiber induced losses. 
Material losses include Rayleigh scattering, ultraviolet (UV), infrared (IR) absorption, 
and hydroxyl (OH) absorption losses. Material losses are the limiting losses in fibers. 

Fiber loss is defined as the ratio of the optical output power  from a fiber of length 
L to the optical input power . The symbol á is commonly used to express loss in 
decibels per kilometer:

Rayleigh scattering model
Because of the granular appearance of atoms or molecules of the glass fiber, light 
transmitted through the fiber suffers scattering loss. This is known as Rayleigh 
scattering loss.

Rayleigh scattering losses in a fiber are typically determined through experimental 
measurement. The loss is expressed in decibels per kilometer through [Buck, 
1995[4]]:

For a single-component glass such as 

where  is the refractive index, p is the photoelastic coefficient, is the thermal 
compressibility, k is the Boltzmann coefficient, and T is the absolute temperature of 
the sample.

Ultraviolet absorption model
Ultraviolet or UV absorption results from electronic absorption bands in the ultraviolet 
region. The electronic absorption bands are associated with the band gaps of 
amorphous glass materials. Absorption occurs when a photon interacts with an 
electron in the valence band and excites it to a higher energy level. The UV absorption 
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at any wavelength can be expressed as a function of the mole fraction x of 
[Buck, 1995[4]]:

UV loss is small compared to scattering loss in the near infrared region.

OH-radical absorption model
The OH radical of H2O molecule vibrates at a fundamental frequency corresponding 
to IR light wavelength of . Since the OH radical is slightly anharmonic, 
“overtones” can occur. These cause OH absorption lines to occur at , 
0.95,and , the second, third, and fourth harmonics of fundamental 
frequencies, respectively. Broad peaks can appear [see, for example, Marcuse, 
1981[7]]. OH absorption can be characterized by fitting the absorption lines by 
Lorentzian or Gaussian method.

Lorentzian fit method:

Gaussian fit method:

In the above two equations,  is amplitude,  is absorption peak position, and  
is the width of the i-th absorption line. Using up to seven absorption lines fits the OH 
absorption spectrum here.

In contemporary state-of-the-art fibers the hydroxyl-group absorption is greatly 
reduced, and only the peak at  still retains some practical 
importance.
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Infrared absorption model
Infrared or IR absorption is associated with the characteristic vibration frequency of 
the particular chemical bond between the atoms of which the fiber is composed. An 
interaction between the vibrating bond and the electromagnetic field of the optical 
signal results in a transfer of energy from the field to bond, thereby causing 
absorption.

The IR absorption expression for  glass is [Buck, 1995[4]]:

Macrobending loss model
The macrobending loss  is a radiative loss when the fiber bend radius is large 
compared to the fiber diameter. It is defined as usual by P(z)=P(0) exp  where 
P(0) is the input power and P(z) is the output power at distance z respectively.

Currently OptiFiber implements two different macrobending loss models:
1 The first model uses the closed-form integral formula, published by J. Sakai and 

T. Kimura [J. Sakai and T. Kimura, 1978[26]]. It is appropriate for calculating the 
macrobending loss of any LP mode, both fundamental and higher-order, in 
arbitrary-index profile optical fibers. Using this formula the macrobending power 
loss coefficient is expressed as a function of the bending radius  in the form:

The parameters appearing above are given by:

(the normalized dimensionless frequency)
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where  denotes the fibre core radius,  is the maximum value of the 
refractive index and  is the cladding index,  is the propagation 
constant of the mode,  is the prop. constant in vacuum, is the azimuthal 
mode number,  if  or  for  and  is the modified 
Bessel function of the second kind of order .

2 Using the second macrobending loss model the coeficient  can be expressed 
as [Snyder and Love, 1983[20]]:

where  is the radial field of the fundamental mode:

and N(R) is the refractive index profile of the fiber. The other parameters are 
given above.

The two models give similar results for step-index fibers.

The loss coefficient  can be converted to loss in decibels per kilometer units as 
follows: 
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Microbending loss model
Microbending loss is a radiative loss in fiber resulting from mode coupling caused by 
random microbends,

which are repetitive small-scale fluctuations in the radius of the curvature of the fiber 
axis.

An approximate expression for the attenuation coefficient is given by [Petermann, 
1976[12]]:

where A is a constant,  is the near field diameter,  is the core refractive index 
of fiber, k is the free space wavenumber, and p is the exponent in the power law.

Splice loss model
A splice is the dielectric interface between two optical fibers. Any index-of-refraction 
mismatch at any point in this interface will produce reflection and refraction of the light 
incident at that point. For splicing calculations, we assume that the mode field of 
single-mode fibers is nearly Gaussian. The coupling losses for the splicing connectors 
can be calculated by evaluating the coupling between two misaligned Gaussian 
beams.

Based on the above model, the coupling loss between two single mode fibers is given 
by [Miller and Kaminow, 1988[10]]:
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where

The symbols above are:

- core refractive index of the fiber

- refractive index of the medium between the two fibers

(37)
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- wavelength

- near field mode field radius of transmitting fiber

- near field mode field radius of receiving fiber

- lateral offset

- longitudinal offset

- angular misalignment

λ

w1

w2

x

z

θ
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Fiber Birefringence Models

Fiber birefringence definition
The birefringence is defined by the difference between the propagation constants of 
the polarization Eigenmodes, that is:

The Differential Group Delay (DGD) per unit length is defined by:

Intrinsic perturbations birefringence
Intrinsic perturbations are accidentally introduced in the manufacturing process and 
are permanent feature of the fiber. These include a noncircular core and 
nonsymmetrical stress fields in the glass around the core region. A noncircular core 
gives rise to geometric birefringence, whereas a nonsymmetrical stress field creates 
stress birefringence. These results were obtained by the perturbation theory and 
applied only for step index fibers.

Elliptical core birefringence definition
The geometrical anisotropy of a non-circular core introduces a linear birefringence in 
the fiber. This birefringence depends strongly on the frequency, or on the normalized 
frequency V, at which the fiber is being operated.

The non-circulatory or ellipticity of the core is defined by the parameter :

where a and b are respectively the minor and major axis of the elliptical core.

The birefringence induced by an elliptical core is linear. The fast axis and slow axis of 
the birefringence corresponds respectively to the major and minor axis of the ellipse.

In the case of a step index fiber, the birefringence

(44)
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is given by [Sakai and Kimura, 1981[17]]:

where

is the relative index difference between the core refractive index and the cladding 
refractive index .

The wave propagation constant is

The function G(V) in the birefringence formula is given by

with the following definitions of waveguide parameters
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where a is the core radius.

The Differential Group Delay (DGD) per unit length is

where c is the speed of light in vacuum.

Internal stress birefringence definition
Stress birefringence caused by a nonsymmetrical stress field in the core region of a 
fiber typically arises in combination with noncircular fiber geometry. The necessarily 
different chemical composition of the core relative to the cladding in single-mode fiber 
usually results in a slightly different thermal expansion coefficient for the two regions. 
This gives rise to radially directed stresses when the fiber is cooled after being drawn.

In an ideal, circularly symmetrical fiber, these stress fields are symmetrical and thus 
do not cause anisotropy. However, if there is a noncircular shape to either the core or 
the cladding in the preform, the drawn fiber will have internal stress fields that are not 
circularly symmetrical.

In a step index fiber with an elliptical core, the birefringence is given by [Sakai and 
Kimura, 1982[18]]:

where
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is the difference between the thermal expansion coefficients of the core  and 
cladding 

and

is the difference between the room temperature  and the softening temperature 
 of the more heavily doped material.

The remaining symbols in the above internal-stress induced birefringence are: 

- core ellipticity

- Poisson’s ratio

- the Young modulus

- photoelastic constant

- wave propagation constant in vacuum

- the average core radius

- the cladding outer diameter of the fiber

and

The symbols U,V, and W are defined in section: Elliptical core birefringence definition.

The Differential Group Delay (DGD) per length unit is given by:
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Extrinsic perturbations birefringence
Birefringence can also be created in a fiber when it is subjected to external forces in 
handling or cabling. Such extrinsic sources of birefringence include lateral stress, 
fiber bending and fiber twisting. All three of these mechanisms are usually present to 
some extent in spooled and field-installed telecommunications fiber.

Lateral stress birefringence definition
When two equal and opposite forces p act across an axis of a fiber with a diameter d, 
the birefringence induced is linear. The fast axis of birefringence is aligned with the 
axis defined by the two opposite forces. 

The birefringence is given by [Sakai and Kimura, 1981[17]]:

where

- photoelastic constant

- lateral force

- wave propagation constant in vacuum

- the outer diameter of the fiber

- the average core radius

and H(V) was defined previously in the section: Internal stress birefringence 
definition.

The Differential Group Delay (DGD) per unit length  is:

Bending birefringence definition
Bending on a fiber with a bending radius R >> a (fiber core) gives rise to a linear 
birefringence. The fast axis of birefringence is perpendicular to the bending plane. 
The slow axis is aligned with the bending radius.

The birefringence is given by [Sakai and Kimura, 1981[17]]:
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with R being the bending radius, and other symbols are:

- the outer diameter of the fiber

- the Young modulus

- photoelastic constant

- wave propagation constant in vacuum

- the average core radius

and H(V) was defined previously in the section: Internal stress birefringence 
definition.

The Differential Group Delay (DGD) per unit length is:

Bending under tension birefringence definition
If we consider a pure axial stress applied to the fiber, simple symmetry considerations 
show that there is no induced birefringence. But winding a fiber with axial tension f 
onto a drum introduces an additional linear birefringence that adds to the bending 
birefringence. This tension-coiled birefringence results from the lateral force exerted 
by the drum on the fiber in reaction to the tensile force f.

The definition is given by [Sakai and Kimura, 1981[17]]:
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where

- photoelastic constant

- axial tension

- wave propagation constant in vacuum

- bending radius

The Differential Group Delay (DGD) per unit length is given by:
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Polarization Mode Dispersion Models

Polarization mode dispersion
In ideal single-mode fibers, propagation constants of the two polarization Eigenmodes 
are degenerate. In real telecommunications fibers, perturbations act on the fiber in a 
way that it induces a birefringence, which splits this degeneracy. Consequently, when 
a pulse is launched in a fiber, it gives rise to a differential group delay between the two 
polarization Eigenmodes. The stochastic behavior of these perturbations is an issue 
because it yields to the phenomenon of random mode coupling which makes 
impossible the basic definition of the differential group delay.

Principal states of polarization
The Principal States of Polarization (PSP) model [Poole and Wagner, 1986[14]] is 
based on the observation that at any given optical frequency, there exists a set of two 
mutually orthogonal input states of polarization for which the corresponding output 
states of polarization are independent of frequency to first order. The Differential 
Group Delay (DGD) resulting from Polarization Mode Dispersion (PMD) is then 
defined between the two output principal PSPs.

The birefringence in telecommunication single-mode fibers varies randomly along the 
fiber length, an artifact of variation in the drawing and cabling process. Furthermore, 
owing to the temperature dependence of many of the perturbations that act on the 
fiber, the transmission properties typically vary with ambient temperature. In practice, 
fluctuations in temperature strongly affect PMD time evolution. To evaluate properties 
of long fiber spans, one adopts a statistical approach. In this case of long span fibers, 
the polarization Eigenstates can only be defined locally and the birefringence vector 
has to be considered as stochastic.

Dispersion vector definition
In the time domain, the Polarization Mode Dispersion (PMD) induces a time shift 
between the two Principal States of Polarization (PSP). 

In the frequency domain, the output state of polarization undergoes a rotation on the 
Poincaré sphere about an axis connecting the two PSPs.

The rate and direction of rotation is given by the dispersion vector  given by:

where - represents the negative output principal state.

The strength of the dispersion vector  is equal to the differential delay time  
between the two output principal states, where its combined Stokes vector 
corresponds to the Stokes vector of the negative output principal state. The direction 
of the Dispersion Vector  defines an axis whose two intercepts with the surface of 
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the Pointcaré sphere correspond to the two principal states of polarization at the fiber 
output. 

Poincaré sphere
The Poincaré sphere is a graphical tool that allows convenient description of polarized 
signals and polarization transformations during propagation. A point within a unit 
sphere can uniquely represent any state of polarization, where circular states of 
polarization are located at the poles. The coordinates of a point within or on the 
Poincaré sphere are the normalized Stokes parameters.

Ensemble simulation
Based on the Principal States of Polarization (PSP) model, one can model the whole 
fiber as a sum of N trunks where each trunk represents a uniform and constant 
birefringent device. A recursive formula describing the evolution of the dispersion 
vector for N and N-1 concatenated trunks is the basis for the calculus of the first and 
second order of the Differential Group Delay (DGD) induced by the Polarization Mode 
Dispersion (PMD).

In the ensemble simulation model, the PMD calculation is repeated in a number of 
runs. First, a set of concatenated fiber trunks is generated randomly. Then the 
polarization mode dispersion is calculated. In the second run, a second set of trunks 
is generated, followed by the PMD calculations. The process is repeated as many 
times as it is required. Statistics of the PMD are calculated using the same number of 
runs as the ensemble representation.

Spectral simulation
In the frequency domain, the Polarization Mode Dispersion (PMD) causes the state 
of polarization at the output of a fiber to vary with frequency for a fixed input 
polarization, which occurs in a cyclic fashion. When displayed on the Poincaré 
sphere, the polarization at the output moves on a circle on the surface of the sphere 
as the optical frequency is varied. 

In the spectral simulation, a set of concatenated fiber trunks is generated randomly. 
The calculations of polarization mode dispersion are performed over a range of 
wavelengths.

First order dispersion definition
The Differential Group Delay (DGD) that is calculated based on a stochastic fiber 
model (first order PMD) quantifies the first order Polarization Mode Dispersion. 

This latter represents the discrete model for Polarization Mode Dispersion (PMD) and 
is given by the following recursive formula [Bruyère, 1994[3]]
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where

In the above, the symbol W with index N represents the birefringence of the fiber. It 
consists of a background linear birefringence  on top of which is added a 
perturbation birefringence . On the Poincaré sphere, the  vector is 

 and the  vector is , respectively. The above 
recursive formula represents the discrete version of the Poole’s dynamical equation 
[Poole et al., 1991[16]].

Mean value of the first order PMD

For a long fiber span, the average Differential Group Delay (DGD) has a square root 
dependence on fiber length z as follows:
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Root Mean Square (RMS) of the first order PMD

The root mean square differential delay time has also a square root of length 
dependence: 

The probability Density Function (PDF) of the differential delay time is Maxwellian:

Second order dispersion definition
The second order Polarization Mode Dispersion (second order PMD) is defined by the 
following expression [Foschini and Poole, 1991[6]]:

where the first frequency derivative of the dispersion vector :

The dispersion vector is defined in the section: Dispersion vector definition.
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Effective Nonlinear Refractive Index
Usually one of the design goals when constructing a fiber is to minimize its 
nonlinearities. The effective nonlinear coefficients of optical fibers depend on the 
nonlinear indices of the bulk materials building the fiber and on its waveguiding 
properties: shape of modes, degree of confinement, etc. As a result it can vary within 
broad limits. OptiFiber calculates the eff. nonlinear coefficient as [Marcuse, 1991[8]]:

where is the user-defined spatially dependent nonlinear refractive index of 
the various fiber layers and  is the normalized mode field pattern.

Interference (speckle) patterns (linear superposition/composition of 
modal fields)

With OptiFiber the user can calculate the superposition/interference pattern of an 
arbitrary group of modes. Each of the modes has an arbitrary user defined guided 
power and initial phase (a complex weighting coefficient assigned). This feature 
targets applications such as coupling efficiency calculations, switching phenomena in 
a few mode fiber sensors, etc.

Coupling efficiencies (linear decomposition of an input beam)
OptiFiber calculates the per-mode coupling efficiencies (the linear decomposition) of 
a user defined input beam into an arbitrarily selected group of supported modes.

The decomposition coefficient is calculated using the following well-known 
expression:
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where  is the input field,  is the modal field.

Scanning
One of the most powerful features of OptiFiber software is the design optimization by 
means of parameter scanning.“Scanning” is the name of the parametrical calculations 
of some fiber characteristic versus certain technological properties or quantities of the 
fiber design: for example the core/cladding refractive index difference, the spatial 
width or some region, etc. It predicts automatically how any given fiber could be 
optimized versus a design goal, for example small, but non-zero dispersion and 
maximal mode area.

Compatibility with the NR-9200 Optical Fiber Analyzer from EXFO Inc.
Version 1.5 and later versions of OptiFiber are designed and developed to be fully 
compatible with NR-9200 in the sense that it directly imports the ASCII files with the 
experimental refractive index profile data, recorded by the low level drivers of the 
device. It is as a software tool that supplements and extends the fiber characterization 
capabilities of the NR-9200.

When the user chooses a NR-9200 Data File with a valid format the experimental data 
is processed and the following parameters are extracted and imported in OptiFiber:
• Fiber Data: Fiber name, Fiber type, Cladding index
• Measurement Info: Operator, Date, Measurement wavelength, Comments
• Scanning details: Scan type, Data type, Number of points, Scan step, Data format
• The actual data

The input files may contain just one scan (X) or two scans (X and Y).

After that, the experimental data is processed and a single, axially symmetric profile 
is formed from the available raw data.

The details of this process are controlled by the “Refractive index profile 
preconditioning dialog” described in the “Dialog Boxes Reference”. It offers two 
features:
• The ability to define the step (inversely proportional to the resolution) of the 

numerical approximation of the refractive index. This is the minimal refractive 
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index difference between two adjacent experimental points that are to be 
considered belonging to different reference index regions in OptiFiber. It is 
entered as a percentage of the maximal core-cladding difference. Lower values 
mean finer approximation/more layers/longer computations and vice-versa. The 
value of the step should be the best trade-off between accuracy and numerical 
efficiency.

• It offers the user the (optional) choice to reduce the ripples, imperfections and 
spurious mechanical or optical noises of the data by means of low-pass Fourier 
filtering and/or averaging. The bandwidth of the filter is given in percentage of the 
highest frequency of the profile curve as a function of the point number. The 
averaging substitutes every data point with the symmetrical mean value of the 
respective number of adjacent points. When this is not possible (for example the 
first point lacks left-standing neighboring points) the number of averaged points 
is reduced accordingly. The recommended values of the filtering and averaging 
parameters are 10 –15% and 2-3 respectively, however the overall quality of 
smoothing depends also on the value of refractive index step (as described 
above), so the user might prefer to fine-tune these three values for optimal results 
in his particular case.

When the experimental data is imported, the user can proceed with defining other 
parameters of the fiber, altering the profile data manually (for example by merging 
some marginal layers of the cladding) and with running the various models currently 
supported by OptiFiber.

The process of importing NR-9200 data is described in detail in “Tutorial 
Lessons/Lesson 2”. See also the description of the “Menu/Import Profile” command 
and of the “Refractive index profile preconditioning” dialog box.
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  TUTORIAL LESSONS
Tutorial Lessons

Lesson 1: Designing Single Mode Fiber
In this example, we will show you how to simulate a simple single-mode optical fiber 
that is optimized for use in the 1310 nm wavelength region. The main features of 
OptiFiber will be addressed in this example. You can find this example as the SMF-
28.fcd file in the Samples directory.

Defining fiber profile
To define a fiber profile, follow these steps:

Step Action 
1 From the “File” menu click “New” to open a new project.

2 2. Click the “Fiber Profile” icon in the “Navigator” pane.

3 3. In the “Select Profile Type” dialog box click “Refractive Index Profile”

4 4. In the “Fiber Profile” dialog box add two regions: “Region 0” and “Region 1”

For “Region 0”, enter the following data:

Width: 4.15 

Profile: constant

Index: 1.45213

Click “Apply”

For “Region 1”, enter the following data:

Width: 58.35

Profile: constant

Index: 1.44692

Click “Apply”

Enter the wavelength value 1.3 microns.

Your fiber profile should look like the one below:
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Note that both the absolute values of the reference indexes and the normalized 
difference  are shown.

Defining dispersion models
To define a dispersion model, follow these steps:

Step Action 
1 In the “Fiber Profile” dialog box, select “Define” in the “Material Properties” 

group of controls.

2 In the “Material Properties” dialog box, select “Define” in the “Host” section.

3 In the “Parameters of Material” dialog box, select “Pure Silica” from the library 
and press Get, followed by pressing OK to close the “Parameters of Material” 
dialog box. You can see in the “Material Properties “ dialog box that the host 
material is now “Pure Silica”.

4 Similarly as in the previous step, define 3.1% germanium-doped silica for the 
“Dopant+” material

5 Similarly as in the previous step, define 1% fluorine-doped silica for the 
“Dopant-“ material. Thus you defined two reference materials that will be 

∆
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used to calculate the material dispersion and the profile dispersion of the 
fiber.

6 Press OK in the “Material Properties” dialog box to close it.

7 Press OK in the “Fiber Profile” dialog box to close it.

Your “Material Properties” dialog box looks like this:
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Calculating fiber modes
To calculate a fiber profile, follow these steps:

Step Action 
1 Click the “Modes” icon in the “Navigator” pane

2 Select the “LP Modes (Matrix Method)” option

3 Press “Recalculate Modes”. The program provides the modal index at the 
given wavelength and shows a preview of the modal field.

4 In the “Views” window, select the “Mode Field” tab to view the modal field.

5 From the “Graph Tools” toolbar select “X Cut”, then click-and-drag the cursor 
over the graph to inspect the mode field normalized “X-section”. The default 
color for “X Cut” lines is green.

6 From the Graph Tools toolbar select “Y Cut”, then click-and-drag the cursor 
over the graph to inspect the mode field normalized Y-section. The default 
color for “Y Cut” graph lines is red.

When you click-and-drag the left mouse button inside your “Mode Field” view tab with 
“X Cut” and “Y Cut” active, then the view looks like this:
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Calculating cutoff wavelength
To calculate the cutoff wavelength, follow these steps:

Step Action 
1 Click the “Cutoff” icon in the “Navigator” pane.

2 Select the “LP Modes (Matrix Method)” option.

3 Press “Recalculate”. The program shows guided modes on the list. If only 
LP01 is supported – decrease the wavelength.

4 Select the “LP11” mode on the list.

5 Press the Calc. “Cutoff” button. The program shows:
— a “theoretical” cutoff wavelength value of 1.33204 microns.
— a “ITU-T” compliant cutoff value of 1.231 microns.

Calculating properties of fundamental mode
To calculate the properties of the fundamental mode, follow these steps:

Step Action 
1 Click the “Scan Fundamental Mode” icon in the “Navigator” pane.

2 In the “Properties of Fundamental Mode” dialog box, select all available 
“Calculate” options

3 Leave the defaults for material, bending, and splice loss parameters

4 In the “Scan” section list, select “Wavelength”, which is also the default 
option. 68

5 In the “Parameter” section, enter “From” = 1.2, “To” = 1.6, “Steps” = 100.

6 Click “Calculate”.
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Viewing results
You can inspect the output graphs in the Views window by selecting appropriate tabs:
• “Modal Index” tab: Plot of the modal index vs. the current scanning parameter, i.e. 

wavelength
• “Group Delay” tab: Plots the group delay vs. the scanning parameter.
• “Dispersion” tab: Plots material, waveguide and total dispersion vs. the scanning 

parameter. The zero dispersion wavelength and the slope are shown on the 
graph.

• “Mode Measures” tab: Plots the near-, far-field, effective mode field diameter and 
the effective mode area vs. the scanning parameter.

• “Material Loss” tab: Plots the material loss vs. wavelength.
• “Bending Loss” tab: Plots the micro and macro bending losses vs. the scanning 

parameter.
• “Splice Loss” tab: Plots the splice loss vs. the scanning parameter.
• “Eff. Nonlinear RI” tab: Plots the effective nonlinear refractive index of the fiber vs. 

the scanning parameter.

Simulating polarization mode dispersion

Birefringence

To simulate the birefringence, follow these steps:

Step Action 
1 Click the “Birefringence” icon in the “Navigator” pane

2 In the “Birefringence” dialog box, check the “Induced by Perturbation 
Parameters” option. The “Photoelastic Constants” entries become available.

3 In the “Photoelastic Constants” section, enter: Young Modulus 7750000000, 
C 3.44e-011, Poisson Ratio 0.164.

4 In the “Induced by Perturbation” Parameters section, check “Extrinsic”, 
“Bending”, and “Fiber Spooled With Tension”.

5 Enter the “Bending” value 0.12

6 Enter the “Fiber Spooled with Tension” value 0.5.

7 In the “Output” section, enter “Spectral Range” 0.4 and “Number of Steps” 51.

8 Press OK to close the “Birefringence” dialog box

9 Go to the “Birefringence” view tab. The birefringence and Differential Group 
Delay (DGD) vs. wavelength are plotted there.

Your “Birefringence” view tab should look like this:
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Polarization mode dispersion

To simulate the polarization mode dispersion, follow these steps:

Step Action 
1 Click the “PMD” icon in the “Navigator” pane

2 Define the parameters for PMD simulation: Fiber Length 1000, Coupling 
Length 20. The Birefringence Characteristics are provided for your 
information and are disabled in this dialog box.

3 Choose “Spectral simulation”: Spectral Range 0.1, Number of Steps 201.

4 Press “OK” to close the polarization Mode dispersion dialog box and start the 
simulation.

5 Go to the “PMD” graphics tab. The first order and second order PMD vs. 
wavelength are plotted for spectral simulation. (For Ensemble simulation, the 
first order PMD vs. Number of Runs would be plotted).

Your “PMD” view tab should look something like this:
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Also, you will have the mean value and the root mean square, (RMS value) of the first 
and second order PMD displayed in a separate window.
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Performance Characterization
Here is the table that compares OptiFiber results with a typical fiber (Corning SMF-
28.):

The data of SMF-28 were taken from the public-domain specifications at Corning’s 
web-site www.corning.com/opticalfiber/

Corning is a registered trademark and SMF-28 is a trademark of Corning 
incorporated, Corning, NY, USA.

Characterized Parameter Calculated Value Typical value

Zero dispersion wavelength, 1.309 1.302 < <1.322

Zero dispersion slope, S0 0.0856 ps/( *km) <0.089ps/( *km)

Eff. MFD at 1310nm 8.9

EFF. MFD at 1550nm 9.9

Effective group index 1.4676 1.4675

Cut-off wavelength of LP11 1.23 <1.260

λ0 µm µm λ0 µm

nm2 nm2

µm 9.20 0.4µm±

µm 10.4 0.5µm±

µm µm
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NOTES:
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Lesson 2: Characterizing A Real Fiber Sample
OptiFiber 1.5 directly supports experimental reference. index profiles scanned with 
the NR-9200 optical fiber analyzer from EXFO Inc. The fiber parameters calculated in 
that way provide indispensable feedback information to the product designer and 
reduce the optimization cycle and the time-to-market.

The experimental profile “FromNR9200.asc” and the OptiFiber project 
“FromNR9200.fcd” used in this lesson can be found in the Samples directory.

Experimental procedures

Step Action 
1 First measure the refractive index profile of the fiber sample under test as 

described in the user manuals of NR-9200. The raw scanned profile data 
usually look as in the picture below. The X- and Y-axis scans are shown in 
different colors.

2 Save the refractive index data using the native NR-9200 format in a file 
named, for example, “FromNR9200.asc” . . “.asc” is the default file extension, 
however the profile files may have any extension, provided their internal 
structure is in the NR-9200 format.

3 Transfer this file to the computer, where OptiFiber is installed.
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Importing the experimental profile
OptiFiber is loaded with drivers that directly interpret the experimental data measured 
and recorded by NR-9200. In order to use the profile data of the sample under test do 
the following:

Step Action 
1 Start a new blank project by selecting “File/New”

2 Import “FromNR9200.asc” by selecting “File/Import Profile…” . Within the 
“File Open” dialog select “Files of Type” - “EXFO NR-9200 Data File (*.asc)”, 
which is the default file type.

3 After the file has been read the “Refractive index profile preconditioning 
dialog” appears:
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It offers the choice of reducing the number of fiber layers (which is typically > 1000) 
in a search for a reasonable compromise between accuracy and computer load. It 
allows also to filter and smooth the profile.

4 Select the default resolution step of 0.0, which means that every experimental 
point will be interpreted as a distinct layer, and press “OK”.

5 At that point OptiFiber processes the experimental profile: makes it 
symmetrical, finds the axis position, etc. (see Technical Background/ 
Compatibility with the NR-9200 Optical Fiber Analyzer …). The adapted 
profile looks in the “Profile” view tab of OptiFiber as shown below… 

If the user is interested in the general trend of fiber parameter change vs. some 
technological parameter (layer thickness, reference. difference) instead of its exact 
absolute value, he may prefer to delete manually some of the cladding layers. The 
next profile is obtained from the one shown above after such operation.
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In that way the number of layers is reduced by ~75%, which greatly alleviates the 
resource needs of the optimization calculations. When the trends in the behavior of 
the design vs. its parameters are known, the user can return to the initial full profile.
88



  TUTORIAL LESSONS
Calculating the parameters of the fiber sample

• Proceed with the usual routines. For example, the calculated dispersions and 
MFD of that particular experimental profile are shown in the following 
pictures:
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NOTES:
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Lesson 3: Designing Dispersion Shifted Fiber
In this example, we will show you how to simulate optical fiber that has a triangular 
with annular ring profile. In addition, we will show you how to optimize given fiber 
profile to have zero dispersion at 1550 nm by the powerful parameter scan routines 
of OptiFiber.

You can find this example as the DSF.fcd file in the Samples directory.

Defining fiber profile
To define a fiber profile, follow these steps:

Step Action 
1 From the “File” menu click “New” to open a new project.

2 Click the Fiber Profile icon in the “Navigator” pane.

3 In the Fiber Profile dialog box, add four regions: “Region 0” through “Region 
3”

For “Region 0”, enter the following data:

Width: 3.1

Profile: function

Function: linear

Refr. Index: Define: Start = 1.4615, End = 1.44692

Steps: 100

Click Apply

For “Region 1”, enter the following data:

Width: 0.6

Profile: constant

Index: 1.44692

Click Apply

For “Region 2”, enter the following data:

Width: 1.5

Profile: constant

Index: 1.45

Click Apply
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For “Region 3”, enter the following data:

Width: 57.

Profile: constant

Index: 1. 44692

Click Apply

Enter the wavelength value 1.3 microns.

Your fiber should look like the one below:

4 Click “OK” to close the “Fiber profile” dialog box.
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Finding the zero dispersion wavelength
To find the zero dispersion wavelength, follow these steps:

Step Action 
1 Click the “Modes” icon in the “Navigator” pane

2 Select the “LP Modes (Matrix Method)” option

3 Press “Recalculate ”. The program provides the modal index at the given 
wavelength and shows a preview of the modal field.

4 Click “OK” to leave the “Modes” dialog box.

5 Click the “Scan Fundamental Mode” icon in the “Navigator” pane.

6 In the “Properties of Fundamental Mode” dialog box, click “Calculate” to scan 
“Wavelength” from 1.4 to 1.6 in 50 steps.

7 Go to “Dispersion” view tab. The zero dispersion wavelength is located in the 
vicinity of 1513 nm.

Your “Dispersion” view tab should look like this:
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Optimizing profile for a required zero dispersion wavelength
Now, we can use the powerful capability of OptiFiber to scan over our design 
parameters. Let’s define, as a design goal, to achieve zero dispersion at a certain 
wavelength, say 1550 nm. As we will see, we can accomplish that by changing, for 
example, the distance between the triangular core and the annular ring, i.e. the width 
of “Region 1”.

When we find the optimal width we can use it to calculate the global dispersion 
characteristics vs. wavelength.

Step Action 
1 Now, go back to the “Properties of Fundamental Mode” dialog box by 

selecting “Scan Fundamental Mode” in the “Navigator” pane.

2 In the “Properties of Fundamental Mode” dialog box, select “Region 1” from 
the “Scan” upper list, then select “Width” from the “Scan” lower list.

3 In the “Parameters” section, enter the following values: From 0.1, To 3.1, 
Steps 30.

4 Click “Calculate”.

5 Go to “Dispersion” view tab. The dispersion vs. the width of the intermediate 
layer is shown there:
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6 6. From the previous dispersion vs. wavelength picture we know that we need 
~ 3 [ps/nm/km] reduction of the total dispersion at 1550 nm. With the left 
mouse button, click-and-drag over the “Total dispersion” curve to find the 
point, whose dispersion is 3 [ps/nm/km] less than the dispersion, 
corresponding to the current width of 0.6 ìm. One can see that the 3 
[ps/nm/km] reduction falls between the widths of 1.3 and 1.4 ìm.

7 Go back to the “Fiber Profile”, select “Region 1”, and change its width to 1.32 
ìm.

8 Go to the “Properties of Fundamental Mode” dialog box and scan over the 
wavelength from 1.4 to 1.6 ìm in 50 steps.

9 Go to “Dispersion” view tab. The zero dispersion wavelength is 1550 nm.

You just optimized the fiber design to obtain the zero-dispersion wavelength close to 
1.55 microns.
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Your “Dispersion” view tab should look like this:
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Lesson 4: Designing Dispersion Flattened Fiber
In this example, we will simulate a dispersion flattened fiber. We will also demonstrate 
the use of the internal scripting language of OptiFiber for defining profiles.

You can find this example as the DFF.fcd file in the Samples directory.

Defining fiber profile
To define a fiber profile, follow these steps:

Step Action 
1 From the “File” menu click “New” to open a new project.

2 Click the “Fiber Profile” icon in the “Navigator” pane.

3 Add four regions in the new profile. For “Region 0” enter the following data:
Width: 4.2
Profile: user function
Click “Define” to enter the script parser editor. In its window enter the 
following expression:

background = 1.4437
delta = 0.01
alpha = 10
background + delta*(1-(x /WIDTH)^alpha)

(Thus you defined one half of an “alpha profile” function using the interpreted script 
language of OptiFiber.)

Click “OK”
Steps: 20
Click “Apply”

4 For “Region 1”, enter the following data:
Width: 2.5
Profile: constant
Index: 1.4437
Steps: 1
Click “Apply”

5 For “Region 2”, enter the following data:
Width: 6.75
Profile: user function
Click “Define” to enter the script parser editor. In its window enter the 
following expression:
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background = 1.44692
delta = 0.003
alpha = 10
background + delta*(1-((2*x - WIDTH)/WIDTH)^alpha)

Click “OK”
Steps: 30
Click “Apply”

6 For “Region 3”, enter the following data:
Width: 49.05
Profile: constant
Index: 1.44692
Steps: 1
Click “Apply”

You fiber profile dialog should look like the one below:
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Calculating the characteristics of the dispersion flattened fiber
To calculate the characteristics of the dispersion-flattened fiber, follow these steps:

Step Action 
1 Click the “Modes” icon on the “Navigator” pane

2 Select the “LP Modes” option

3 Press “Recalculate Modes”. The program provides the modal index at the 
given wavelength and shows a preview of the modal field.

4 Click “OK” to leave the “Modes” dialog box.

5 Click the “Scan Fundamental Mode” icon in the “Navigator” pane.

6 In the “Properties of Fundamental Mode” dialog box, click “Calculate” to scan 
the wavelength from 1.3 to 1.8 in 50 steps.

7 Go to “Dispersion” view tab. The total dispersion is small and uniform within 
the 1.3 - 1.8 ìm wavelength range.
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Your Dispersion view tab should look like this:

You may experiment with scanning some fiber profile parameters, as in “Lesson 3: 
Designing Dispersion Shifted Fiber” in order to obtain even better dispersion flatness 
or certain value of the average dispersion within a wavelength interval of interest.
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Commands Reference

File Menu Commands

New command
The “New” command opens a new OptiFiber file with empty “Views” window, except 
the “Material Loss” view. Fiber parameters have default values. OptiFiber creates a 
default name for the newly opened file.

This command can be accessed from:
• File menu
• Standard toolbar

Open command
The “Open” command opens an existing OptiFiber file. The “Views” window tabs are 
empty, except the “Profile” view and the “Material Loss” view. Fiber parameters have 
the last saved values.

This command can be accessed from:
• File menu
• Standard toolbar

Close command
The “Close” command closes the active OptiFiber file. The program prompts for 
saving fiber parameters.

This command can be accessed from:
• File Menu
• Standard toolbar

Save command
The “Save” command saves the active OptiFiber file. The file is saved under the 
current name.

This command can be accessed from:
• File Menu
• Standard toolbar

Save As
The “Save As” command saves the active OptiFiber file. The program prompts for a 
file name.
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This command can be accessed from:
• File menu

Export Profile command
The “Export Profile” command saves the existing refractive index profile in an ASCII 
file. The file is saved in the OptiFiber’s own text format.

This command can be accessed from:
• File menu

Import Profile command
The “Import Profile” command loads a file with a refractive index profile data in 
OptiFiber. The file should be in one of the supported formats. Currently two formats 
are supported:
• EXFO’s proprietary NR-9200 file format
• OptiFiber’s own text format

However, any ASCII data representing a refractive index profile can easily be 
transformed by the user into the OptiFiber’s format (for example using MS Excel) and 
imported for modeling.

This command can be accessed from:
• File menu

For description of the OptiFiber’s format, see the respective section in the “Technical 
background”

Print command
The “Print” command prints the active output view.

This command can be accessed from:
• File menu
• Standard toolbox

Print Preview command
The “Print Preview” command shows the active output view on the screen as it would 
appear after print with current print settings.

This command can be accessed from:
• File menu

Print Setup command
The “Print Setup” command allows to change the default printer, paper, and 
orientation.

This command can be accessed from:
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• File menu

Recent Files command
The “Recent Files” command refers to the list files at the bottom of the “File” menu. 
By selecting one of the files, the user opens that file.

Exit command
The “Exit” command of the “File” menu stops the OptiFiber program. The program 
prompts for saving unsaved files.

View Menu Commands

Status Bar
The “Status Bar” command toggles the display of the status bar at the bottom of the 
OptiFiber workspace window.

This command can be accessed from:
• View menu

Navigator command
The “Navigator” command toggles the display of the “Navigator” pane in the OptiFiber 
workspace window.

This command can be accessed from:
• View menu

Toolbars command
The “Toolbars” command toggles the display of the toolbars in the OptiFiber 
workspace window.

This command can be hid or displayed:
• Standard toolbar
• Graph Tools toolbar

This command can be accessed from:
• View menu

Views command
The “Views” command switches the display of the output “Views” window.

This command can be accessed from:
• View menu
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The following views can be accessed by this command:
• Profile view
• Modal Index view
• Group Delay view
• Dispersion view
• Mode Measures view
• Material Loss view
• Bending Loss view
• Splice Loss view
• Mode Field view
• Birefringence view
• PMD view
• Effective Nonlinear Refr. Index
• Comments

Fiber Menu Commands

Profile command
The “Fiber” command opens the “Fiber Profile” dialog box, where you can design the 
refractive index profile of the fiber and have access to the dispersion properties of the 
fiber materials.

This command can be accessed from:
• Fiber menu
• Fiber Profile icon on the Navigator pane:

Simulation Menu Commands

Modes command
The “Modes” command opens the “Modes” dialog box, where you can perform initial 
calculations and select fiber modes to be calculated further.

This command can be accessed from:
• Simulation menu
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• Modes icon on the Navigator pane:

Fundamental Mode command
The “Fundamental Mode” command opens the “Properties of Fundamental Mode” 
dialog box, where you can select calculation options for the fundamental fiber mode.

This command can be accessed from:
• Simulation menu
• Fundamental Mode icon on the Navigator pane:

Higher Order Modes command
The “Higher Order Modes” command opens the “Properties of Higher Order Mode” 
dialog box, where you can select calculation options for a higher order fiber mode.

This command can be accessed from:
• Simulation menu
• Higher Order Mode icon on the Navigator pane:

Cutoff command
The “Cutoff” command opens the “Cutoff” dialog box, where you can calculate the 
cutoff wavelength for a selected higher mode.

This command can be accessed from:
• Simulation menu
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• Cutoff icon on the Navigator pane:

Birefringence command
The “Birefringence” command opens the “Birefringence” dialog box, where you can 
enter the fiber birefringence data.

This command can be accessed from:
• Simulation menu
• Birefringence icon on the Navigator pane:

PMD command
The “PMD” command opens the “Polarization Mode Dispersion” dialog box. When the 
“Birefringence” command was not previously executed, then the program opens the 
“Birefringence” dialog box first and, after performing the birefringence calculations, 
opens the “Polarization Mode Dispersion” dialog box.

This command can be accessed from:
• Simulation menu
• PMD icon on the Navigator pane:

Tools Menu Commands

Settings command
The “Settings” command opens the “Global Settings” dialog box, where you can set 
up graphics properties for the output views.
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This command can be accessed from:
• Tools menu

Table command
The “Table” command opens the “Table” dialog box, where you can preview, copy (for 
pasting in another application, such as Excel) or export to a text file the numerical 
values that correspond to the current output view.

This command can be accessed from:
• Tools menu

Calculated results command
The “Calculated results” opens the “Calculated results” dialog box, where you can 
preview, copy (for pasting in another application, such as Excel) or export to a text file 
the numerical values that correspond to the last calculation.

Window Menu Commands

New Window command
The “New Window” command creates a copy window of the active output view 
window. The program adds a default name to the newly created window.

This command can be accessed from:
• Window menu

Cascade command
The “Cascade” command creates a cascade view of the output view windows within 
the OptiFiber workspace.

This command can be accessed from:
• Window menu

Tile command
The “Tile” command creates a tile view of the output view windows within the 
OptiFiber workspace.

This command can be accessed from:
• Window menu

Arrange Icons command
The “Arrange Icons” command orderly arranges iconized view windows within the 
OptiFiber workspace.

This command can be accessed from:
• Window menu
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List of Windows command
The “List of Windows” area at the bottom of “Window” menu contains a list of the 
currently loaded windows. By selecting one of them, the user activates it.

Graph Tools Commands

“Joints” command
The “Joints” command activates the display of data points in the active output view. 
The data points are marked as small circles.

This command can be accessed from:
• Graph Tools toolbar
• Floating menu (right mouse button on a graph)
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“Zoom XY” command
The “Zoom XY” command serves to expand horizontally and vertically a part of the 
active output view.

This command can be accessed from:
• Graph Tools toolbar
• Floating menu (right mouse button on a graph)

To use this command:

Step Action 
1 Select “Zoom XY” from the Graph Tools toolbar or from the floating graph 

menu.

2 Now, with the left mouse button, click-and-drag a horizontal and vertical 
region to be expanded to a full graph. For example, before you release the 
left mouse button, your “Material Loss” view should look something like this:
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After you release the left mouse button, the selected horizontal and vertical region is 
expanded to the full view.
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To revert to the original graph, select “Zoom Off” from the floating menu or ”Graph 
Tools“ toolbar.

“Zoom X” command
The “Zoom X” command works identically with “Zoom XY” command except that it 
expands the view only in horizontal direction.

“Zoom Off” command
The “Zoom Off” command turns off the current expansion in graph view and returns 
the graph settings to the default scale.

This command can be accessed from:
• Graph Tools toolbar
• Floating menu (right mouse button on a graph)

“Measure” distance command
The “Measure” distance command activates the display of two crossing-line sets in 
the active output view. The horizontal and vertical crossing lines show two data points 
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on a curve along with a display of their XY coordinates and distances. The displayed 
coordinates refer to the curve data points.

This command can be accessed from:
• Graph Tools toolbar
• Floating menu (right mouse button on a graph)

To use this command:

Step Action 
1 Select “Measure” from the “Graph Tools” toolbar or from the floating graph 

menu.

2 Click the curve with the left mouse button. The nearest data point is displayed 
as a small circle with a set of XY lines passing through it. The point 
coordinates are displayed along the XY lines.

3 Move the cursor along the curve. During that move, the point closest to the 
cursor will be displayed as small circle with a second set of XY lines passing 
through it. The second set of lines displays the second point coordinates as 
well as the XY distances from the first point.
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The “Measure” distance tool works well with the “Joints” command active.

“Tracking” command
The “Tracking” command activates the display of a crossing-line set in the active 
output view. The horizontal and vertical crossing lines show data points on a curve 
along with a display of their XY coordinates.

This command can be accessed from:
• Graph Tools toolbar
• Floating menu (right mouse button on a graph)

To use this command:

Step Action 
1 Select “Tracking” from the “Graph Tools” toolbar or from the floating graph 

menu.

2 Click the curve with the left mouse button. The nearest data point is displayed 
as a small circle with a set of XY lines passing through it. The coordinates of 
the point are displayed along the XY lines.
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Note: The simplest way to use this command is to click-and-drag on the 
graph using only the left mouse button. In that case you do not need to use 
the Graph Tools toolbar nor the floating menu.

The “Tracking” tool works well with the “Joints” command active.

“Legend” command
The “Legend” command toggles the display of the curves legends in the output 
“Views” window.

This command can be accessed from:
• Graph Tools toolbar
• Floating menu (right mouse button on a graph)

For example the Material Loss view legend looks like this:
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You can drag the legend around the graph to position it in a convenient spot.

“Grid X” command
The “Grid X” command toggles the display of the vertical grid in the active output 
Views window.

This command can be accessed from:
• Graph Tools toolbar

When you select the “Grid X” command, your display will have a set of vertical lines. 
The grid lines correspond to the coordinate-labeled points on the X-axis.
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You can combine the “Grid X” and “Grid Y” command to obtain a rectangular XY grid 
on the display.

“Grid Y” command
The “Grid Y” command toggles the display of the vertical grid in the active output 
Views window.

This command can be accessed from:
• Graph Tools toolbar

When you select the “Grid Y” command, your display will have a set of horizontal 
lines. The grid lines correspond to the coordinate-labeled points on the Y-axis.
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You can combine the “Grid X” and “Grid Y” command to obtain a rectangular XY grid 
on the display.

“X Cut” command
The “X Cut” can be used in the “Mode Field” output view. It allows you to track an X 
cross-section of the

XY mode field. By default it is turned on.

This command can be accessed from:
• Graph Tools toolbar

To use this command

Step Action 
1 Select “X Cut” from the Graph Tools toolbar.

2 In the “Mode Field” view, click-and-drag the X-section position along the Y-
axis. Along with the X-section green horizontal line , the program displays the 
X-section field curve.
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On the graph, there are two vertical scales: one corresponding to the Y-dimension of 
the fiber, and the other one corresponding to the mode field section.

“Y Cut” command
The “Y Cut” can be used in the Mode Field output view. It allows you to track a Y 
cross-section of the XY mode field. By default it is turned on.

This command can be accessed from:
• Graph Tools toolbar

To use this command:

Step Action 
1 Select “Y Cut” from the “Graph Tools” toolbar.

2 In the “Mode Field” view, click-and-drag the Y-section position along the X-
axis. Along with the Y-section red vertical line, the program displays the Y-
section field curve.
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On the graph, there are two vertical scales: one corresponding to the Y-dimension of 
the fiber, and the other one corresponding to the mode field section.
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Dialog Boxes Reference

Fiber Profile Related Dialogs

Select Profile Type dialog box
Currently OptiFiber supports two types of profiles
• Refractive index profile
• Dopant concentration profile

The “Select Profile Type” dialog box offers a choice between them. After that it pops-
up the “Fiber Profile” dialog box.

Fiber Profile dialog box
The “Fiber Profile” dialog box helps you design the refractive index profile of the fiber.

To access this dialog box do one of the following:
• Select “Profile” on the “Fiber” menu, or
• Click the “Fiber Profile” icon in the “Navigator” pane

When the profile type is “Refractive index” the dialog box looks as shown:
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When the profile type is “Dopant concentration” the dialog box look as shown:
123



  COMMANDS REFERENCE
The elements and controls of the “Fiber Profile” dialog box are described below.

List of Regions

Shows the radial refr. index or concentration regions by their names.

Add

Adds a region to the list.

Delete

Deletes the selected region from the list.

Up

Moves the selected region one position up the list.

Down

Moves the selected region one position down the list.
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Region Name

Edits and changes the name of the selected region.

Info

Opens the “Region Info” display box, where you can see the region refractive index 
with its start and end values. This option is particularly useful when dealing with user 
defined regions, where the start and end index values may not be obvious.

Width

Enter the width of the selected region in microns.

Profile

Select one of the following options for the index profile within the current region:
• Constant - Constant value of the refractive index.
• Function - Functional dependence of the index, where the function is selected 

from the list in the “Function” option (see “Function” below for the list of available 
functions).

• User Function - Functional dependence of the index, where the function is defined 
or programmed using the powerful Script Language environment.

Refr. Index / Molar Concentration [%]

Depending on the select profile type this edit control is interpreted in two different 
ways:

Refr. Index

Depending on the “Profile” option, you have different options for the “Refr. Index” 
entry:
• Numerical data entry box - Present when the “Constant” profile option was 

selected. Enter the refractive index value for the selected region.
• “Define” button - Present when the “Function” or “User Function” option was 

selected. Press the “Define” button to specify the function. For the “Function” 
profile option, a dialog box related to one of the predefined functions appears. For 
the “User Function” profile option, pressing the “Define” button launches the “User 
Defined Function” script programming environment.

Molar Concentration [%]

Similar to the previous case, however all numerical values are interpreted as molar 
concentration percentages, instead of refractive indices.

Position

Shows the region radial position in microns. The region position is measured from the 
fiber center to the beginning of the region.
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Function

This option is enabled when the “Function” profile option is selected. The program 
provides the following predefined index functions:
• Linear
• Parabolic
• Gaussian
• Exponential
• Alpha-peak
• Alpha-dip

The notation convention for these functions is described in the “Technical 
Background”, section “Refractive Index of Fibers”. Usually, the functions' argument is 
the radial local distance that is zero at the beginning of the region and is equal to the 
“Width” value at the end of the region.

Steps

Enter the number of steps for discretization of the index profile function. The OptiFiber 
mode solver requires the step-like discretization of smooth index profiles. Increasing 
the number of steps provides better mode solving accuracy, however, at the expense 
of calculation time.

Enable

Enable the material dispersion model for the current region. To access the model 
definition press the “Define” button in the “Material Properties“ section of the dialog 
box (also see “Material Properties” dialog box).

Global

Assign the global material dispersion model to the current region. The global model 
assumes that a fiber is formed by doping the host material with one dopant that rises 
the refractive index and another dopant that lowers the index (see “Material 
Properties” dialog box).

Define

Opens the “Material Properties” dialog box, where you can assign material dispersion 
model based on the Sellmeier coefficients library or on your custom model, as well as 
nonlinear refractive index of the material.

Wavelength

The wavelength entered here is considered the measurement wavelength, that is, the 
wavelength at which the current profile is exact. At other wavelength values used in 
the program, for example when scanning over a spectral range, the profile shape is 
adjusted accordingly based on the material dispersion model.

Apply

Apply the changes made in the dialog box.
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Display

This group of controls allows to show the profile in one of the two alternative ways: 1) 
as a refractive index profile, or 2) as dopant concentration profile. A check-box that 
switches the color-coding of the profile on/off is also available.

Info dialog box
The “Info” dialog box displays the selected index profile region. You can see the 
region refractive index with its start and end values. This option is particularly useful 
when dealing with user defined regions, where, due to the functional dependence, the 
start and end index values may not be obvious.

To access this dialog box, do the following steps:

Step Action 
1 Open the “Fiber Profile” dialog box.

2 Click the “Info” button.
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Material Properties dialog box
The “Material Properties” dialog box looks and functions differently in dependence if 
the type of profile is “Refractive Index” or “Dopant Concentration”.

Material Properties dialog box (Profile type is “Refractive Index” )

The “Material Properties” allows the user to specify the Sellmeier and nonlinear 
coefficients of the fiber material. It also displays the material refr. index as a function 
of wavelength. For the dispersion model it is assumed that the fiber profile consists of 
regions with only the host material and doped regions. One of the dopants rises the 
refractive index, while the other dopant lowers it.

To access this dialog box, do the following steps:

Step Action 
1 Open the “Fiber Profile” dialog box.

2 Select “Enable” in the “Material Properties” section.

3 Press the “Define” button in the “Material Properties” section.
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The elements and controls of the “Material Properties” dialog box options are 
described below.

Host

Shows the name of the fiber host material. Press “Define” to specify the material and 
its dispersion model. When the “User” option is cleared, the “Define” button activates 
the “Parameters of Material” dialog box. When the “User” option is checked, the 
“Define” button launches the “User Defined Function” script programming 
environment (see the Script Language section of the documentation).

Dopant +

Shows the name of the fiber material that has higher index due to an index-rising 
dopant. The “Define” button and the “User” option work the same way as for the “Host” 
option.
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Dopant -

Shows the name of the fiber material that has lower index due to an index-decreasing 
dopant. The “Define” button and the “User” option work the same way as for the Host 
option.

Update

Update the dispersion display after recent changes.

Display From

Enter the minimum wavelength for the dispersion display.

Display To

Enter the maximum wavelength for the dispersion display.

Host, Dopant + and Dopant – check boxes

Serve to switch on /off the display of the respective curves

Material Properties dialog box (Profile type is “Dopant Concentration” )

The “Material Properties” allows the user to specify the chemical composition, 
Sellmeier and nonlinear coefficients of the fiber material. It also displays the material 
refractive indices of the pure host material, the dopant and the doped material as a 
function of wavelength.

To access this dialog box, do the following steps:

Step Action 
1 Open the “Fiber Profile” dialog box.

2 Select “Enable” in the “Material Properties” section.

3 Press the “Define” button in the “Material Properties” section.
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The elements and controls of the “Material Properties” dialog box options are 
described below.

Host

Shows the name of the fiber host material. Press “Define” to specify the material and 
its dispersion model. When the “User” option is cleared, the “Define” button activates 
the “Parameters of Material” dialog box. When the “User” option is checked, the 
“Define” button launches the “User Defined Function” script programming 
environment (see the Script Language section of the documentation).

Dopant

Shows the name of the material doping the host. The “Define” button and the “User” 
option work the same way as for the “Host” option.
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Molar Concentration of Dopant

Enter the molar concentration of the doping material in [%].

Update

Update the dispersion display after recent changes.

Display From

Enter the minimum wavelength for the dispersion display.

Display To

Enter the maximum wavelength for the dispersion display.

Host, Dopant and Doped Material

Serve to switch on /off the display of the respective curves

Parameters of Material dialog box

The “Parameters of Material” dialog box allows you to specify:
• The material dispersion model based on the Sellmeier theory. OptiFiber uses six 

Sellmeier coefficients, three wavelengths and three amplitudes, to define the 
dispersion curve.

• The nonlinear coefficient of the material
• The molar concentration of dopant in case the profile type is ”dopant 

concentration”.

To access this dialog box, do the following steps:

Step Action 
1 Open the “Fiber Profile” dialog box.

2 Select “Enable” in the “Material Properties” section.

3 Press the “Define” button in the “Material Properties” section. The “Material 
Properties” dialog box opens.

4 In it press the “Define” button for formulate the material model of the host or 
the dopants.
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Sellmeier Formula

The Sellmeier formula is displayed for reference. The formula reads:

where n is the wavelength-depended refractive index, A1, A2 and A3 are the 
Sellmeier amplitudes, and  are the Sellmeier resonance wavelengths.

The elements and controls of “Parameters of Material” dialog box are described 
below.
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Name

Enter the name of the material. If you select the material from the Library list (see Get 
below) then the name appears automatically.

A1, A2, A3

Enter the amplitude Sellmeier coefficients.

Enter the wavelength Sellmeier coefficients.

NonLinear Refractive Index

The nonlinear refractive index of the bulk material, as defined for example in [G. 
Agrawal, 1995].

Add

If you entered new material along with its Sellmeier coefficients, you can add it to a 
data base library by pressing the Add button. Using this feature the user can build rich 
user-defined material libraries.

Delete

Delete the selected material from the library.

Get

Get the material from the Library list. The library materials are stored in a data base. 
OptiFiber provides some of the known materials along with the Sellmeier coefficients.

Profile Function Parameters dialog box
The “Profile Function Parameters” dialog box allows you to define the relevant 
parameters of the profile function in the current region.

It covers the following types of function profiles (see also the “Refractive Index of 
Fibers” section in the “Technical Background”):

λ1 λ2 λ3,,
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• Linear index profile:
• Exponential index profile:

To access this dialog box, do the following steps:

Step Action 
1 Open the “Fiber Profile” dialog box.

2 Select the region profile as “Function”.

3 In the “Function” list, select Linear, Parabolic, or Exponential.

4 Press the “Define” button.

The elements and controls of “Profile Function Parameters” dialog box are described 
below.

Start

Enter the start value of the refractive index or the concentration at the beginning of 
the region.

End

Enter the end value of the refractive index or the concentration at the end of the 
region.

Gaussian Function Parameters dialog box
The “Gaussian Function Parameters” dialog box allows you to specify the relevant 
parameters when the

profile function in the current region is Gaussian (see also the “Refractive Index of 
Fibers” section in the “Technical Background”).

To access this dialog box, do the following steps:

Step Action 
1 Open the “Fiber Profile” dialog box.

2 Select the region profile as “Function”.

3 On the “Function” list, select “Gaussian”.

4 Press the “Define” button.
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The elements and controls of “Gaussian Function Parameters” dialog box options are 
described below.

Nmax

Enter the maximum value of the refractive index described by the Gaussian function.

Norm. FWHM

Enter the normalized Full Width at Half Maximum (FWHM) of the Gaussian function.

Center Position

Enter the peak position of the Gaussion function. The position is measured from the 
beginning of the current region.

Parabolic Layer Parameters
The Parabolic Layer Parameters dialog box specifies relevant parameters for function 
layers of parabolic type.  See the Technical Background for the formula defining the 
parabolic layer.  To access this box, perform the following steps

1. Open the Fiber Profile dialog box
2. Select the Region profile as Function
3. On the function list, select Parabolic
4. Press the Define button 
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The elements of the Parabolic Layer Parameters dialog box are listed below

Orientation – indicates whether the curve will start at the left and go the right side of 
the layer (the default), or if the direction is to go the other way.  In the default position, 
the extremum of the parabola is on the left, the other orientation will put the extremum 
on the right side.

Start - enter the refractive index of the layer at the start (left side in Left to Right 
orientation)

End - enter the refractive index of the layer at the end (right side in Left to Right 
orientation)

Alpha Power Law Function Parameters dialog box

The “Alpha Power Law Function Parameters” dialog box allows you to specify the 
relevant parameters when the profile function in the current region is of the following 
types (see also the “Refractive Index of Fibers” section in the “Technical 
Background”):
• Alpha –peak index profile:
• Alpha –dip index profile:
137



  COMMANDS REFERENCE
To access this dialog box, do the following steps:

Step Action 
1 Open the “Fiber Profile” dialog box.

2 Select the region profile as “Function”.

3 On the “Function” list, select “Alpha-Power Peak” or “Alpha-Power Dip”.

4 Press the “Define” button.

The elements and controls of “Alpha Power Law Function Parameters” dialog box 
options are described below.

Max Ref Index

Enter the maximum value of the refractive index described by the Alpha-Power 
function.

Norm Index Difference %

Enter the normalized index difference of the Alpha Power function.

Alpha Value

Enter the alpha power coefficient value.

User Defined Function dialog box
The “User Defined Function” dialog box allows you to define unusual, specific 
functional dependencies of the profile or the material dispersion model. The user 
defined function can be almost anything that conforms to the rules of the Script 
Language programming.
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Working with user defined functions

Since User Defined Functions are important for your work, you may want to have a 
look at the following example:

Let's say that you want to use a user-defined function to define a fiber profile region. 
To do this, open the “Fiber Profile” dialog box and select the index region where you 
want the user function to apply. Next, select the “User Function” profile option for that 
region and press “Define” under the “”Refr. Index” or “Molar Concentration” heading 
(depending on profile type) to open the “User Defined Function” dialog box. It is split 
into two: the editing area and the display area.

The Editing Area

You define the function in the editing area. For your convenience, the editing area is 
a simplified programming editor. To define a function, you type the function formula 
or simply select a function from a combo box (see below: Using Combo Boxes). In the 
formula, you can use numbers, constants, variables, and other functions. Standard 
mathematical operators are supported. The program keeps a list of mathematical 
constants, design (global) variables, and mathematical functions. 

In general, the User Defined function has one independent variable, called x.

The Display Area

The graph of the function is shown in the display area.
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Working in the Editing Area

Let's assume that you need the profile of the zero-order Bessel function, J0(x/s), 
where s=4. All you have to do is type the following two lines in the User Function 
Definition editing area:

s=4

bessj0(x/s)

Exploring the User Defined Function program editor

As mentioned above, the editing area is a simplified programming editor. You can 
write your own functions and also test and debug the program. The format of the 
language is very close to BASIC. For more information, see the Script Language 
documentation.

Using Combo boxes

There are three combo boxes. Each of them contains an icon and a list of options:

The icon on the left side of any combo box is for inserting a selected item into the text 
(at the cursor position). The list of options in the first combo box contains all constants, 
in the second one all functions, and in the last one the actual global variables. The 
question marks on the right side of the first and the second combo box will give you a 
short help about a constant or a function. (Usually a value for a constant and syntax 
for a function.)

Using the Display Steps box

You use the “Display Steps” box for testing. In this box, you type the number of points 
you will calculate when you press the Display button in the display area. The number 
you type in this box is not the number of points this function will calculate in a real 
calculation. To do the calculation, just press the “OK” button in the display area.

Running the Program and Debugging

The User Defined Function program editor allows you to Debug and Run (Display) the 
program.

Run

The "!" button, has exactly the same function as the Display button. It is put on the 
Toolbar for convenience.
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Debug

You can not only run your program but also debug it. If the function is not simple, i.e. 
it may have an IF - THEN structure for example, and gives you bad results, you can 
easily debug your program by pressing the Debug button and following the prompts. 
In that case, you will see two new windows. The first one contains the Source Code 
and shows you where you are in debugging; the second one contains a list of all 
global (system defined) and local (defined by you) variables.

Exploring the Display Area

In the display area, you see the actual graph. You can also define the variable range 
of x in the “From” and “To” boxes.

The Progress check box

If you enable the “Progress” check box, you will be able to see the Progress Bar while 
the program is running. To perform this, you have to enable the Progress check box 
and press the Display button. You may want to disable the Progress check box if you 
are using some output windows or FOR - NEXT loops that will give you many 
Progress/Message bars.

The Load and Save buttons
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You can load or save any functions to disk as a separate text so that you can build 
your own library of new functions.
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Refractive index profile preconditioning dialog
This dialog box controls the process of importing experimental refractive index data 
scanned with the NR- 9200 Optical Fiber Analyzer from EXFO Inc.

The elements and controls of “Profile Function Parameters” dialog box are described 
below.

Resolution step

This is the minimal refractive index difference between two adjacent experimental 
points that are to be considered belonging to different refr. index regions in OptiFiber. 
It is entered in percentage of the core/cladding difference of the current profile. By 
choosing larger step the user can reduce the number of fiber layers at the expense of 
lower refractive index resolution. As the number of experimental points could be quite 
large (thousands) the choice of the step is a matter of a reasonable compromise 
between accuracy and computer load. A step value of 0 (the default value) means that 
every experimental point will be considered a separate layer/region in OptiFiber.
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Low-pass FFT filtering / Averaging

These two features serve to smooth the experimental profiles and remove ripples, 
small spurious peaks due to vibrations, etc. The Filtering/Averaging operations are 
optional, not obligatory and can be skipped. Therefore the respective areas of the 
dialog are initially grayed. However, in such cases the number of interpreted fiber 
layers and thus the computational effort are increased considerably. If the user opts 
to smooth the profile, he has to activate the respective controls by checking the check-
boxes “FFT Filter On” and/or “Averaging On”.
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Fiber Modes Related Dialogs

Modes dialog box
The “Modes” dialog box allows you to:
• Select the types of modes you are interested in
• Select the range of mode numbers you are interested in
• Find the spectrum of supported modes at the specified wavelength with their 

mode numbers and effective refractive indices
• Select a mode or group of modes for subsequent calculations.
• Preview the mode pattern of a selected mode in a number of ways.
• “Compose” a beam by the interference of an arbitrary group of supported modes.
• “Decompose” in input beam into an arbitrary group of supported modes (calculate 

input coupling efficiencies.)

To access this dialog box, do one of the following steps:

Step Action 
1 Select “Modes” on the “Simulation” menu, or

2 Click the “Modes” icon in the “Navigator” pane

The elements and controls of “Modes” dialog box options are described below.
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LP Modes (Finite Difference Method)

Check this option to calculate fiber propagation modes in the Linear Polarization (LP) 
approximation (scalar modes). LP(m,n) modes are conventionally labeled using two 
numbers: the azimuthal number m (the Order), and the radial number (mode number) 
n. You can select the range of Order and the maximum n number for the solver.

LP Modes (Matrix Method)

This option finds LP modes as above, but by an exact method that uses radial transfer 
matrices. See Appendix A - Fiber Mode Solvers by Matrix Method for details. This 
method sometimes runs more slowly, especially if the profile has many layers. 
However, the far field has the correct asymptotes, and this method is more accurate, 
especially in the calculation of dispersion and other derivatives with wavelength.

Vectorial Modes

Check this option to calculate fiber propagation modes without the scalar 
approximation. Conventionally, the vector modes have subsets of the hybrid HE and 
EH modes, the Transverse Electric (TE) modes, and the Transverse Magnetic (TM) 
modes. Hybrid (m,n) modes are conventionally labeled using the numbers: the 
azimuthal number m (Order), and the radial number n. The vector modes are found 
by a 4x4 transfer matrix method, see Appendix A - Fiber Mode Solvers by Matrix 
Method for details.

Wavelength

This is the wavelength the calculated spectrum of modes relates to. It is independent 
of the wavelength specified in the “Fiber Profile” dialog box.

Recalculate

Press the “Recalculate” button to start the mode solver.

List of modes

The results found by mode solver are displayed in the list of modes. The modes are 
labeled according to the calculation option, with the modal index beside the label.

Modal Index Export

Export the contents of “List of modes” to a text file.

Mode field preview

Mode field can be previewed on the small display, where you can select the display 
color mode and contrast.

Composition

Starts the “Composition” dialog box allowing to calculate arbitrary interference 
combinations of the currently selected group of modes.
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Decomposition

Starts the “Decomposition” dialog box allowing to calculate the coupling efficiencies 
of an arbitrary input beam into each mode of the currently selected group of modes.

Composition dialog box
This dialog box controls the calculation of the superposition/interference pattern of an 
arbitrary group of modes each of them having arbitrary power and input phase.

To use this feature, do the following steps:

Step Action 
1 In the “Modes” dialog box, select a group of modes by using Ctrl-, Shift- and 

the left mouse button.

2 Press the “Composition” button. In the “Composition” dialog box, enter the 
weighting coefficient for each mode.

3 Press “OK”

The elements and controls of “Composition” dialog box options are described below.
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Weighting coefficients table

Enter the complex coefficients assigned to each participating mode in the three-
column table (grid) in the upper left part of the dialog box

Preview display area

The graphical window in the lower right part of the dialog box shows a color-coded 
topological view of the current pattern.

Calculate

Find the current interference pattern as defined by the set of modes and the 
coefficients.

Define the Mesh

Increase/Decrease the resolution of the preview screen.

Norm Coef.

Normalizes the weighting coefficients. After normalization, the sum of the squared 
magnitudes of all of the weighting coefficients is equal to 1.

Load Coef.

Load the weighting coefficients to a text file.

Save Coef.

Save the weighting coefficients to a text file.

Zoom

Check this option to zoom the details of the speckle pattern. Useful for fibers with 
narrow core and wide cladding.

Power/Field

Diplay the intensity or the amplitude of the composed field.

Save field

Saves the calculated field to a text file. The saved file has the complex BCF3DCX 3D 
file Format, described in the “Technical Background”.

Propagation Length

When this field is 0.0, the preview is the sum of the modes with amplitudes and 
phases as indicated in the list. Enter a distance in microns in this field, and press 
Calculate, to see the field as it would appear after a propagation of this distance.
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Linear decomposition of a given field distribution
This dialog box controls the calculation of the per-mode coupling efficiencies (the 
linear decomposition) of an user defined input beam into an arbitrarily selected group 
of supported modes.

To use this feature, do the following steps:

Step Action 
1 In the “Modes” dialog box, select a group of modes by using Ctrl-, Shift- and 

the left mouse button.

2 Press the “Decomposition” button. In the “Decomposition” dialog box, define 
the parameters of the input beam.

3 Press “OK”

The elements and controls of “Decomposition” dialog box options are described 
below.
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Calculate

Find the decomposition coefficients for the current set of modes and the current input 
beam.

Weighting coefficients table

Contains the calculated field (with their real and imaginary parts) and power 
decomposition coefficients. The values in the “Power” are the squared sum of the real 
and imaginary parts and have the meaning of the usual coupling coefficients.

From File

Read the input beam from a user defined file having the BCF3DCX complex 3D file 
Format (please see the description in “Technical Background”).

Gaussian

The input beam is modeled as Gaussian field defined by the several parameters, 
FWHM Width and polar angle.

Gaussian for Decomposition

Where

Center

The center position  of the input Gaussian beam.

Width

The width  of the input Gaussian beam.

Mesh

The number of point of the internal calculations. Higher value means better accuracy 
of the coefficients at the expense of computating time.

Angle

Enter the polar angle between the input beam and the fiber axis.

Save Coef.

Export the coefficients to a text file.
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Properties of Fundamental Mode dialog box
The “Properties of Fundamental Mode” dialog box controls the powerful parameter 
scanning routines of OptiFiber related to the fundamental mode. It also allows the 
user to select which characteristics of the fundamental mode to be calculated.

To access this dialog box, take one of the following steps:

Step Action 
1 1. Select “Fundamental Mode” on the “Simulation” menu

2 2. Click the “Fundamental Mode” icon in the “Navigator” pane 

In the case of a simple step-index fiber it look as shown:

In order to use this dialog the user should have defined a legitimate profile in the 
“Profile” dialog box.
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The elements and controls of the “Properties of Fundamental Mode“ dialog box are 
described below.

Scan

The “Scan” section is split into two panes.
• The upper pane lists what is subjected to scanning:

• The wavelength within a spectral region.
• The profile as a whole within user-specified limits, for example 

between 0.8 and 1.2 of the original width. This means that all spatial 
dimensions of the original design are proportionally shrunk/expanded 
at regular steps from 0.8L to 1.2L, where L is the initial width.

• The single spatial regions of the profile.
• The lower pane lists the various technological parameters of the current region 

that are available for scan calculations.

When “Wavelength” or “Profile Width” is selected in the upper pane, then there is no 
other parameter to scan. When a region is selected, then all region parameters 
available for scan calculations are displayed in the lower pane. Their number and 
physical meaning depends on the type of the region. The available parameters may 
include function parameters for function-defined regions. For example:
• If a simple “constant” region is selected, then for scanning are available:

• its spatial width and
• maximal refr. index

• If a “Gaussian function” region is selected, then for scanning are available:

• its spatial width
• maximal refr. index
• FWHM and
• central position

Parameters

The “Parameters” section refers to the range of parameter being scanned and the 
number of steps. “From” - Initial value of the scan parameter “To” - Final value of the 
scan parameter “Steps” - Number of calculation steps in the scan calculations

Calculate

The “Calculate” section allows you to select the fundamental mode characteristics to 
be calculated versus the scan parameter.

The options are:
• Group Delay and Dispersion
• Mode Field Diameter
• Bending Loss
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• Splice Loss
• Effective nonlinear coefficient

The Material Loss option always refers to scanning over the wavelength parameter. 
You start the calculations by pressing the “Calculate” button.
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Properties of Higher Order Modes dialog box
The “Properties of Higher Order Modes” dialog box controls the powerful parameter 
scanning routines of OptiFiber related to a higher order mode or a group of modes. It 
also allows the user to select which modal characteristics to be calculated.

To access this dialog box, take the following steps:

Step Action 
1 Select “Higher Order Modes” on the “Simulation” menu, or

2 Click the “Higher Order Modes” icon in the “Navigator” pane

In order to use this dialog the user should have:
• Defined a legitimate profile
• Solved for the spectrum of modes in the “Modes” dialog box and found that the 

fiber is multi-mode at that wavelength.
• Selected in the “Modes” dialog box

• a higher order mode, or
• a group of modes
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If some of these conditions are not fulfilled, the user is automatically sent to the 
respective place of

OptiFiber to alter the design, to solve for modes, etc.

The logic of the scanning routines depends alternatively on the number of modes that 
have been selected in the “Modes” dialog box. In the case of one selected higher 
mode the “Properties of Higher Order Modes” works in the same way as the 
“Properties of Fundamental Mode” dialog – it allows the defined characteristics of that 
mode to be calculated versus some scanned parameter.

In the case of multiple selected modes the “Properties of Higher Order Modes” 
calculates the defined characteristics of each mode. An option is offered to sort and 
display the results:
• according the sequential number of the modes in the selected group.
• according the effective refr. index of the modes in descending order.

The elements and controls of “Properties of Higher Order Modes” are almost the 
same as those of the “Properties of Fundamental Mode” dialog box and will not be 
described separately.

Note: The calculations are performed for the mode or modes previously selected 
in the “Modes” dialog box.

Cutoff dialog box
The “Cutoff” dialog box finds the spectrum of supported modes at a specified 
wavelength, to select a set of the supported modes, and to find their cutoff 
wavelengths. For explanation of the methods used to estimate the cutoffs, please 
refer to the section “Cutoff Wavelengths” in the “Technical Background”.

To access this dialog box, take the following steps:

Step Action 
1 Select “Cutoff” on the Simulation menu, or

2 Click the “Cutoff” icon in the “Navigator” pane

3 Enter wavelength and click Recalculate.
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The elements and controls of the “Cutoff” dialog box are described below.

LP Modes (Finite Difference Method)

Check this option to calculate fiber propagation modes in the Linear Polarization (LP) 
approximation (scalar modes). LP(m,n) modes are conventionally labeled using two 
numbers: the azimuthal number m (the Order), and the radial number (mode number) 
n. You can select the range of Order and the maximum n number for the solver.

LP Modes (Matrix Method)

This option finds LP modes as above, but by an exact method that uses radial transfer 
matrices. See Appendix A - Fiber Mode Solvers by Matrix Method for details. This 
method sometimes runs more slowly, especially if the profile has many layers. 
However, the far field has the correct asymptotes, and this method is more accurate, 
especially in the calculation of dispersion and other derivatives with wavelength.

Vectorial Modes

Check this option to calculate fiber propagation modes without the scalar 
approximation. Conventionally, the vector modes have subsets of the hybrid HE and 
EH modes, the Transverse Electric (TE) modes, and the Transverse Magnetic (TM) 
modes. Hybrid (m,n) modes are conventionally labeled using the numbers: the 
azimuthal number m (Order), and the radial number n. The vector modes are found 
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by a 4x4 transfer matrix method, see Appendix A - Fiber Mode Solvers by Matrix 
Method for details.

Wavelength

The wavelength at which the initial spectrum of modes is calculated. If the fiber is 
single-mode at the specified wavelength – decrease it, in order to be able to select a 
mode for the calculations.

Recalculate

Press the “Recalculate” button to start the mode solver.

List of modes

The results found by mode solver at the specified wavelength are here. The modes 
are labeled according to the calculation option. The mode effective index of each 
modes is given in parenthesis.

Lists of cutoff values

Displays the estimated cutoff wavelength values for the selected modes.

Two lists are available:
• “Theoretical values” and
• “Estimated ITU-T values”

in accordance with the two cutoff definitions. A cutoff wavelength is not defined for the 
fundamental mode

and therefore is marked 'N/A' (although occasionally, for quite inappropriate 
combination of parameters, the fundamental mode could be unsolvable for, a 
condition called “a numerical cutoff”).

Export

Click here to make an ascii text file that contains the modes listed in the columns 
Theoretical values and Estimated ITU-T values.
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Fiber Loss Related Dialogs

Material Loss dialog box
The “Material Loss” dialog box allows you to define parameters for the material loss 
models and preview them on the attached display. The material loss includes the OH 
radicals, infrared, and ultraviolet absorption models, as well as the Rayleigh 
scattering model.

To access this dialog box, do the following steps:

Step Action 
1 Open the “Properties of Fundamental Mode” dialog box

2 Check the “Material Loss” option

3 Press the “Define” button for the “Material Loss” option, or

4 Access it by double-clicking in the “Material Loss” view tab.

The elements and controls of the “Material Loss” dialog box are described below.

Define

You can define the hydroxyl (OH), infrared (IR), ultraviolet (UV) absorption 
parameters, and the Rayleigh scattering parameters by pressing the “Define” buttons 
corresponding to each of the loss listing. If the “User” box is cleared, then the program 
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displays a loss model dialog box that corresponds to the current option. If the “User” 
box is checked, the program launches the “User Defined Function” dialog box, where

you can define custom models.

Display

You can select the wavelength range for the material loss display and toggle between 
displaying different curves.

Update

By pressing the Update button, you can refresh the display after recent changes.

OH Absorption dialog box

The “OH Absorption” dialog box allows you to define the hydroxyl group absorption 
characteristics. The characteristics are defined by fitting to the OH overtone 
resonance curves. You can form the absorption curve either by adding Lorentzian or 
Gaussian shaped resonance.

To access this dialog box, do the following steps:

Step Action 
1 Open the “Properties of Fundamental Mode” dialog box

2 Check the “Material Loss” option

3 Press the “Define” button for the “Material Loss” option

4 Press the “Define” button for the “OH Absorption option” , or

5 Access it by double-clicking in the “Material Loss” view tab.
159



  COMMANDS REFERENCE
The elements and controls of the “OH Absorption” dialog box are described below.

Hydroxyl Group Overtones

The Hydroxyl Group Overtones section refers to resonance in the absorption spectra 
caused by the presence of OH impurities in the fiber material. The OH absorption 
curve is composed of a series of independent resonance characteristics that are 
added together. You can create up to seven resonance by providing their amplitudes, 
central wavelengths, and widths.

Fit Method

The particular resonance may be modeled by Lorentzian or Gaussian curves. You 
select one or the other as the OH absorption fitting model. Formulas for both fitting 
methods are displayed in the dialog box

See also the “OH-Radical Absorption Model” section in the “Technical Background”.

IR Absorption dialog box
The “IR Absorption” dialog box allows you to define the parameters of an 
experimental-fit model of infrared absorption. The experimental fit is based on the 
exponential curve with two parameters.

To access this dialog box, do the following steps:

Step Action 
1 Open the “Properties of Fundamental Mode” dialog box

2 Check the “Material Loss” option

3 Press the “Define button” for the “Material Loss” option

4 Press the “Define” button for the “IR Absorption” option, or

5 Access it by double-clicking in the “Material Loss” view tab.
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The elements and controls of the “IR Absorption” dialog box are described below.

A

Enter the amplitude of the exponential fit curve.

B

Enter the exponential 1/wavelength decay coefficient.

See also the “Infrared Absorption Model” section in the “Technical Background”.

UV Absorption dialog box
The “UV Absorption” dialog box allows you to define the parameters of an 
experimental-fit model of ultraviolet absorption. The fit is based on the exponential 
curve with six parameters.

To access this dialog box, do the following steps:

Step Action 
1 Open the “Properties of Fundamental Mode” dialog box

2 Check the “Material Loss” option

3 Press the “Define” button for the “Material Loss” option

4 Press the “Define” button for the “UV Absorption” option, or

5 Access it by double-clicking in the “Material Loss” view tab.
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The elements and controls of the “UV Absorption” dialog box options are described 
below.

A

Enter the amplitude of the exponential fit curve.

B, C, D

Enter the B, C, and D coefficients of the fit curve.

E

Enter the 1/wavelength decay coefficient of the fit curve.

w

Enter the mole fraction of the impurity.

See also the “Ultraviolet Absorption Model” section in the “Technical Background”.

Rayleigh Scattering dialog box
The “Rayleigh Scattering” dialog box allows you to define the parameters of an 
experimental-fit model of Rayleigh scattering in fibers. The fit is based on the typical 
inverse wavelength dependence of the small dipole scattering.
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To access this dialog box, do the following steps:

Step Action 
1 Open the “Properties of Fundamental Mode” dialog box

2 Check the “Material Loss” option

3 Press the “Define” button for the “Material Loss” option

4 Press the “Define” button for the “Rayleigh Scattering” option, or

5 Access it by double-clicking in the “Material Loss” view tab.

The elements and controls of the “Rayleigh Scattering” dialog box options are 
described below.

A

You can adjust only one number, the scattering amplitude A, to fit the Rayleigh 
scattering curve.

See also the “Rayleigh Scattering Model” section in the “Technical Background”.
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Bending Loss dialog box
The “Bending Loss” dialog box allows you to define parameters for the microbending 
and macrobending loss models.

To access this dialog box, do the following steps:

Step Action 
1 Open the “Properties of Fundamental Mode” dialog box

2 Check the “Material Loss” option

3 Press the “Define” button for the “Bending Loss” option

The elements and controls of the “Bending Loss” dialog box options are described 
below.

Microbending

In the microbending loss model, A is an arbitrary fit constant and p is the power 
coefficient. Typical values for A are much smaller than 1, while typical p is about 2.
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Macrobending

In the macrobending loss model you can only select the bend radius. An alternative 
choice between two models is allowed if the selected mode id the fundamental one.

See also the “Macrobending Loss Model” and “Microbending Loss Model” sections in 
the “Technical Background”.

Splice Loss dialog box
The “Splice Loss” dialog box allows you to define parameters for the splice loss 
model. The model is based on a formula derived for the case of two glass rods with 
approximate Gaussian modes. The rods represent cores of two spliced fibers, while 
the finite cladding dimension is ignored - it is assumed that the core rods are in an 
infinite cladding medium.

To access this dialog box, do the following steps:

Step Action 
1 Open the “Properties of Fundamental Mode” dialog box

2 Check the “Material Loss” option

3 Press the “Define” button for the “Splice Loss” option

The elements and controls of the “Splice Loss” dialog box options are described 
below.

Matching Mode Size

Enter the mode size of the other fiber that would be spliced with the fiber under 
design.
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Medium Refractive Index

Enter the common cladding index of the fibers.

Transverse Offset

Enter the transverse offset between the two fibers' axes.

Longitudinal separation

Enter the longitudinal separation gap between the two fibers.

Angular Misalignment

Enter the angular tilt between the two fibers.

See also the “Splice Loss Model” section in the “Technical Background”.
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Fiber Birefringence Related Dialogs

Birefringence dialog box
The “Birefringence” dialog box allows you to define parameters of the fiber 
birefringence model. As described in the “Technical Background”, various 
mechanisms contribute to fiber birefringence. You can simply define birefringence 
values or follow one of the OptiFiber models.

To access this dialog box, do one of the following steps:

Step Action 
1 Select “Birefringence” on the Simulation menu

2 Click the “Birefringence” icon in the “Navigator” pane , or

3 Access it by double-clicking in the “Birefringence” view tab.
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The elements and controls of the “Birefringence” dialog box options are described 
below.

Central Wavelength

Enter the central wavelength for the birefringence calculations.

User Defined

To characterize the birefringence phenomena without OptiFiber models, enter the 
following coefficients:
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• Delta Beta - Difference between the propagation constants of the two 
orthogonally polarized modes

• DGD - Differential Group Delay (DGD) related to fiber birefringence

Photoeleastic Constants

A group of constants characterizes photoelastic properties of the fiber: the Young 
modulus, C coefficient, and Poisson ratio. This section is enabled when you intend to 
use OptiFiber birefringence models.

Induced by Perturbation Parameters

This section refers to birefringence caused by intrinsic and extrinsic fiber 
perturbations.

Intrinsic options:
• Elliptical Core Deformation - Enter the Core Ellipticity parameter.
• Thermal Stress - Enter the Differential Thermal Expansion Coefficient and 

Temperature Difference values.
• Extrinsic options:
• Bending Radius - Enter the bending radius.
• Fiber Spooled with Tension - Enter the tension force value.
• Transverse Pressure - Enter the transverse pressure value.

Output

The birefringence calculations are performed over a spectral range around the 
Central Wavelength value. You enter the spectral range and the number of calculation 
steps.

See also the following sections in the Technical Background:
• Fiber Birefringence Definition
• Intrinsic Perturbations Birefringence
• Elliptical Core Birefringence Definition
• Internal Stress Birefringence Definition
• Extrinsic Perturbation Birefringence
• Lateral Stress Birefringence Definition
• Bending Birefringence Definition
• Bending Under Tension Birefringence Definition
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Polarization Mode Dispersion Related Dialogs

Polarization Mode Dispersion dialog box
The “Polarization Mode Dispersion” dialog box allows you to define parameters of the 
PMD model as well as choose the PMD simulation method as the ensemble 
simulation or spectral simulation. Theoretically, both methods are equivalent.

To access this dialog box, do the following steps:

Step Action 
1 Select “PMD” on the Simulation menu

2 Click the “PMD” icon in the Navigator pane

Note: N.B.! The “Polarization Mode Dispersion” dialog box is accessible only after 
the Birefringence calculation. If the “Birefringence” was not calculated before, its 
dialog box will appear after clicking the “Polarization Mode Dispersion” dialog box.

The elements and controls of the “Polarization Mode Dispersion” dialog box options 
are described below.
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Birefringence Characteristics

This section provides only a display of the birefringence parameters as calculated 
using the Birefringence dialog box setup.

PMD Data

The PMD Data refers to the stochastic trunks model used to calculate the Polarization 
Mode Dispersion characteristics. Enter the fiber length and the coupling length 
parameter.

Ensemble Simulation

With this option selected, the program performs the PMD calculations based on a 
number of stochastic fibers that are generated during the simulation. You enter the 
number of stochastically generated fibers.

Spectral Simulation

With this option selected, the program performs the PMD calculations using only one 
stochastic fiber. However, the calculations are repeated for a number of steps within 
the spectral range. You enter the spectral range and the number of steps.

See also the following sections in the Technical Background:
• Polarization Mode Dispersion
• Principal States of Polarization
• Dispersion Vector Definition
• Poincaré Sphere
• Ensemble Simulation
• Spectral Simulation
• First Order Dispersion Definition
• Second Order Dispersion Definition
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PMD dialog box
The “PMD” dialog box is only a display of the numerical values related to the 
Polarization Mode Dispersion (PMD) calculation.

This dialog box appears automatically when the PMD calculations are finished and 
the PMD tab is selected in the output Views window.
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Graph Related Dialogs

Table dialog box
The “Table” dialog box allows you to inspect and export numerical data related to plots 
in the “Views” window.

To access this dialog box, do the following steps:

Step Action 
1 Select one of the tabs in the output “Views” window

2 Select “Table” on the “Tools” menu

The elements and controls of the “Table” dialog box options are described below.

Numerical Data

The first column lists the current scan parameter, for example the wavelength. The 
subsequent columns display numerical values of curves in the current plot.

Data Export

You can save any of the listed curves to a file.
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Calculated results dialog box
The “Calculated results” opens the “Calculated results” dialog box, where you can 
preview, copy (for pasting in another application, such as Excel) or export to a text file 
the numerical values that correspond to the last calculation.

The elements and controls of the “Calculated results” dialog box options are 
described below.

Check boxes

The different calculated results will be added to this dialog box if it is checked.

The following check boxes are available:
• Modal Index
• Group Delay
• Waveguide Dispersion
• Material Dispersion
• Total Dispersion
• Near Field MFD
• Far Field MFD
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Save result

Press the “Save” button to save the data shown in this dialog box.

Print result

Press the “Print” button to print the data shown in this dialog box.
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Graphic Properties dialog box
This dialog box allows you to tweak the details of the active display view. It is 
accessible through the context menu “Tools” activated by the right button of the 
mouse.

To access the graphic properties dialog box, do the following steps:

Step Action 
1 Go to one of the tabs in “Views” window

2 Click the right mouse button to activate the floating “Tools” menu

3 From the “Tools” menu, select “Graph Properties”

The dialog looks and functions differently depending on the type of graphic. For all the 
2D view tabs it looks as shown:

The user can select/deselect each curve for displaying and can enter the graph title.

If the active view is the topological “Mode Field” view, then the “Graph Properties” 
dialog box looks as shown:
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Its elements and controls are described below.

Display / Export

This option allows the user to select what how to view and/or export the modal field: 
as amplitude or as intensity.
177



  COMMANDS REFERENCE
Export

Determines what characteristic of the modal field to export:
• The topological pattern of the mode. The exported file has a real 3D file Format: 

BCF3DPC (please, see the “Supported File Formats” description at the end of the 
“Technical Background”).

• The current X-cut 2D graph. The exported file has is a simple text file starting with 
a header indicating the Y position of the X-cut and having two columns:

• 1st column - X position,
• 2nd column - amplitude or intensity

• The current Y-cut 2D graph. The file format is the same as in the X-cut case, with 
the meaning of Xand Y- alternatively interchanged.

The currently selected option in “Display / Export” determines whether intensity or 
amplitude will be exported.

Press the ”Export” button to perform the actual file saving.

Modal Field window Parameters

You can specify the modal field window limits by entering values for “X From”, “X To”, 
“Y From”, “Y To”. “Mesh X” and “Mesh Y” are the sampling points in X and Y directions 
and determine the resolution.
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Settings

Global Settings dialog box
The Global Settings dialog box can be used to change OptiFiber’s style of data entry 
and presentation according to user preference.  The information in the Global Settings 
dialog box will be stored in the system registry.  This means that the settings are 
remembered after OptiFiber is closed, and will remain in effect on the current 
computer until changed by this dialog box.  The illustration shows the dialog box with 
its default settings.  To access this dialog box, select Tools >> Settings ...

The elements and controls of the “Global Settings” dialog box options are described 
below.

Graph background

Refers to the graph background in the Views window. The available options are: none, 
wood, paper, and wall.

Mode topographic View

This section refers to graph setup for the mode field display and printing. The default 
background for the mode field display is black, so you may use the Print Inverse 
Colors option.

Display Mesh - Enter the number of points in the X and Y dimension of the mode field 
screen display.
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Print - Enter the number of points in the X and Y dimension of the mode field printed 
picture.

2D Graph

Check Print Curves with Different Styles to distinguish curves on black and white 
output prints.

Profile

Radius specified instead of layer widths – In the Fiber Profile dialog box, the profile 
is specified as a list of Regions (layers) of various widths.  There is a read only field 
to show the position (radius) of the selected layer.  Check this box if you prefer to enter 
the radius of the layer instead of the layer width.  With this box checked, the width field 
will become read only instead of the position field.

Layer index specified relative to cladding – In the Fiber Profile dialog box, the 
refractive index of the selected layer is displayed in the Refr. Index field.  Check this 
box if you prefer to specify the refractive index relative to the cladding layer instead.  
With this box checked, the last layer must be constant, and when the last layer is 
selected, the cladding refractive index, Nc, will be displayed in the Refr. Index field.  
However, when other layers are selected, the index of current layer relative to the 
cladding layer will be shown.  Since these differences are typically small, the 
difference is multiplied by 1000.  When any inner layer is selected, the label of the field 
will change to (N – Nc) * 1000, as a reminder that the refractive index is being 
specified and displayed as a relative value.  The display of refractive index in other 
parts of OptiFiber is not changed by this setting.
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Output Views Reference

Profile view
The “Profile” view shows you the fiber index profile as defined in the “Fiber Profile” 
dialog box.

To access this view do one of the following steps:

Step Action 
1 Select the “Profile tab” in the “Views” window

2 Select “Views/Profile” on the “View” menu

Modal Index view
The “Modal Index” view shows you the effective refractive index of the selected 
propagation mode vs. the scan parameter. The default scan parameter is the 
wavelength. You can change the scan parameter in the “Properties of Fundamental 
Mode” dialog box or in the “Properties of Higher Order Modes” dialog box.
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To access this view do one of the following steps:

Step Action 
1 Select the “Modal Index” tab in the “Views” window

2 Select “Views/Modal Index” on the “View” menu

Group Delay view
The “Group Delay” view shows you the propagation group delay for the selected fiber 
mode vs. the scan parameter. The default scan parameter is the wavelength. You can 
change the scan parameter in the “Properties of Fundamental Mode” dialog box or in 
the “Properties of Higher Order Modes” dialog box.

To access this view do one of the following steps:

Step Action 
1 Select the “Group Delay” tab in the “Views” window

2 Select “Views/Group Delay” on the “View” menu
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Dispersion view
The “Dispersion” view shows you the material, waveguide, and total dispersion 
characteristics vs. the scan parameter. The default scan parameter is the wavelength. 
You can change the scan parameter in the “Properties of Fundamental Mode” dialog 
box or in the “Properties of Higher Order Modes” dialog box.

To access this view do one of the following steps:

Step Action 
1 Select the Dispersion tab in the Views window

2 Select Views/Dispersion on the View menu

Mode Measures view
The “Mode Measures” view shows you the near-field, far-field and effective Mode 
Field Diameters (MFD) and the effective area of the fundamental mode vs. the scan 
parameter. The default scan parameter is the wavelength. You can change the scan 
parameter in the “Properties of Fundamental Mode” dialog box or in the “Properties 
of Higher Order Modes” dialog box.
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To access this view do one of the following steps:

Step Action 
1 1. Select the “Mode Measures” tab in the Views window

2 2. Select “Views/Mode Measures” on the “View” menu

Material Loss view
The “Material Loss” view shows you the material loss characteristics vs. wavelength. 
The loss is defined according to four models in the “Material Loss” dialog box, as well 
as the total material loss curve.

To access this view do one of the following steps:

Step Action 
1 Select the “Material Loss” tab in the Views window

2 Select “Views/Material Loss” on the “View” menu
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Bending Loss view
The “Bending” Loss view shows you the microbending and macrobending fiber loss 
vs. the scan parameter. The default scan parameter is the wavelength. You can 
change the scan parameter in the “Properties of Fundamental Mode” dialog box.

To access this view do one of the following steps:

Step Action 
1 Select the “Bending Loss” tab in the “Views” window

2 Select “Views/Bending Loss” on the “View” menu

Splice Loss view
The “Splice Loss” view shows you the transversal, longitudinal, and angular 
misalignment loss, as well as the mode match and total splice loss vs. the scan 
parameter. The default scan parameter is the wavelength. You can change the scan 
parameter in the “Properties of Fundamental Mode” dialog box.
187



  COMMANDS REFERENCE
To access this view do one of the following steps:

Step Action 
1 Select the “Splice Loss” tab in the “Views” window

2 Select “Views/Splice Loss” on the “View” menu

Mode Field view
The “Mode Field” view shows you a topographic plot of the mode field. The displayed 
mode is the one selected in the Modes dialog box. You can change the display mesh 
in the Global Settings dialog box. Also a X- or Y-cuts (or both) of the mode are shown.

To access this view do one of the following steps:

Step Action 
1 Select the “Mode Field” tab in the “Views” window

2 Select “Views/Mode Field” on the “View” menu
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If the option “Amplitude”, instead of “Intensity” has been selected from the right-button 
context menu “Graph Properties”, then the ”Mode Field” displays a topological color-
coded pattern and 2D X- and Y-cut cross sections of the amplitude of the same field, 
as shown below:
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Birefringence view
The “Birefringence” view shows you plots of:
• Delta Beta - Difference between the propagation constants of the two 

orthogonally polarized modes.
• DGD - Differential Group Delay (DGD) due to fiber birefringence vs. wavelength.

To access this view do one of the following steps:

Step Action 
1 Select the “Birefringence” tab in the “Views” window

2 Select “Views/Birefringence” on the “View” menu
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PMD view
The “PMD” view shows you the Polarization Mode Dispersion (PMD) of the first and 
second orders vs. wavelength.

To access this view do one of the following steps:

Step Action 
1 Select the “PMD” tab in the “Views” window

2 Select “Views/PMD” on the “View” menu
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Effective Nonlinear Refr. Index view
This view shows you the eff. nonlinear refr. index of the fiber as determined by the 
nonlinearity of the bulk materials and the degree of confinement.

To access this view do one of the following steps:

Step Action 
1 Select the “Eff. Nonlinear RI” tab in the “Views” window

2 Select “Views/Effective Nonlinear Refr. Index” on the “View” menu
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Appendix A - Script Language Reference

Overview of Script Language
The script language OptiFiber uses is a programming language based on the BASIC 
language syntax. You use the script language to define the fiber profile, or material 
dispersion, for example. To start programming with the Script Language, you have to 
choose the User Defined option in OptiFiber dialog boxes.

The script language is described in the following reference sections:
• Variables, Arrays, and Operators: Variables, Arrays, Mathematical Operators, 

Boolean Operators, and Comparison Operators
• Commands and Statements: Commands and Statements, RETURN Command, 

IF Statement, ERROR Keyword, FIRSTTIME Keyword, Input Dialog Box, 
Example Input, and Example Ginput

• Predefined Constants: Mathematical Constants and Physical Constants
• Functions Library: Commonly Used Functions, Other Functions, Fresnel Integral, 

Gamma Function, Error Function, Bessel Functions, Chebyshev Polynomials
• Unit Conversions: Length Conversions, Temperature Conversions, Other 

Conversions

Variables, Arrays, and Operators

Variables

A variable name can be any string beginning with a character. You cannot use special 
characters and operators in the name. Some names are reserved for commands, 
predefined constants, and functions. Variable names are case sensitive. For 
example, ‘a’ is not the same as ‘A’, ‘Pos’ is not the same as ‘pos’ or ‘POS’.

Examples:

Valid variable names: a, pos, lambda, width1

Invalid variable names: *a, _pi, IF, RETURN

Note: Comment lines in the editing area are preceded by the double slash symbol 
//.

Arrays
You can use only one-dimensional arrays. You do not have to declare an array before 
using it. For the array index, you can use a positive or a negative integer. The usage 
format is array_name[index].
195



 APPENDIX A - SCRIPT LANGUAGE REFERENCE
Examples:

A[2]

B[-3]

a[x]=x*2

Mathematical Operators
The script language supports the following standard mathematical operators (listed in 
decreasing priority):

^ power operator

* multiplication operator

/ division operator

+ addition operator

- subtraction operator

Boolean operators
The script language supports the following standard Boolean operators:

= 'equal to' operator

< 'less than' operator

> ‘more than' operator

& 'and' operator

| or' operator

Examples:

A=b

A<b

B&c

C|d

Comparison operators
Comparison operators serve to establish relations between two objects. They can be 
combined, for example:

a<=b; a<>b; a=>b
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Commands and Statements

Commands and statements
The script language has a set of commands and control statements. All command and 
statement names must be in upper case letters.

Examples:

IF is a command

If or if can be a variable, but is not a command

RETURN command
The RETURN keyword terminates execution of the program in which it appears and 
returns the control (and the value of expression, if given). Notice that if you don’t 
specify RETURN in your program, the interpreter will return the value of expression 
in the last logical order. You usually use the RETURN command if your program uses 
IF – THEN commands.

Syntax: RETURN[expression]

Example 1:

A program with only one line (you don’t have to specify RETURN):

sin(3)*24+13*(2+6)

returns 107.38688.

The same result is obtained from the program:

RETURN sin(3)*24+13*(2+6)

Example 2:

Consider the program:

cp = 100
a = Length-x
IF x<cp THEN
RETURN x
ELSE
RETURN a

The above program returns x if x is less than 100. Otherwise, it returns Length-x if x 
is larger or equal than 100.
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Example 3:

Let’s modify the previous example, Example 2, as follows:

cp = 100
a = Length-x
IF x<cp THEN
b = x
ELSE
b = a
RETURN b

This example gives the same result as Example 2. The difference is that another 
variable b is used instead of returning the value of a directly.

IF statement
The IF statement controls conditional branching. The body of an IF statement is 
executed if the value of the expression is nonzero. The syntax for the IF statement 
has two forms.

Syntax: IF expression THEN statement ELSE statement

In both forms of the IF statement, the expressions, which can have any value, are 
evaluated, including all side effects. 

In the first form of the syntax, if expression is nonzero (true), the statement is 
executed. If expression is false, statement is ignored. In the second form of syntax, 
which uses ELSE, the second statement is executed if expression is false. With both 
forms, control then passes from the If statement to the next statement in the program.

Examples:

The following are examples of the IF statement:

IF i > 0 THEN y = x / i ELSE x = i

In this example, the statement y = x/i is executed if i is greater than 0. If i is less than 
or equal to 0, i is assigned to x.

For nesting IF statements and ELSE clauses, use BEGIN – END to group the 
statements and clauses into compound statements that clarify your intent. If no 
BEGIN - END are present, the interpreter resolves ambiguities by associating each 
ELSE with the closest IF that lacks an ELSE.

IF i > 0 THEN // Without BEGIN - END
IF j > i THEN
x = j
ELSE
x = i
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The ELSE clause is associated with the inner IF statement in this example. If i is less 
than or equal to 0, no value is assigned to x.

IF i > 0 THEN
BEGIN /* With BEGIN - END */
IF j > i THEN
x = j
END
ELSE
x = i

The BEGIN - END enclosing the inner IF statement in this example makes the ELSE 
clause part of the outer IF statement. If i is less than or equal to 0, i is assigned to x.

ERROR keyword
The ERROR keyword stands for a constant and returns the error code (if any). In case 
of a mathematical error, like division by zero or overflow, it will reset the error flag.

The constant returns the error code (if any) and in cases of mathematical errors 
(division by zero, overflow, etc.) resets the error flag. This allows you to detect any 
unexpected errors during calculation. The best example is to use the ERROR 
command in the IF-THEN-ELSE statement.

Example 1:

The following one-line program:

Length /x

results in the Error message: Division by zero, b=Length/x?????

This is, because initially x has been set to 0.

Example 2:

Consider the program:

b=Length/x
IF ERROR THEN
b=100;
RETURN b

Now, whenever we have a mathematical error, b is set to 100 and the program will 
continue without the error message.

Note: ERROR is a constant, and you cannot assign any other value to it.
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FIRSTTIME keyword
The FIRSTTIME keyword is a flag that indicates the first time internal run.

Example:

S =7
IF FIRSTTIME THEN
RETURN 100
RETURN x*s

Input dialog box
This dialog will appear if you use INPUT or GINPUT in User Defined Functions. I t 
contains a single edit box.

Syntax:

INPUT variable

INPUT “string” variable

INPUT “string” variable = init value

GINPUT variable=init value

GINPUT “string” variable = init value

Example Input
Usage of INPUT is limited. Because in OptiFiber you use user defined functions 
usually in a loop, INPUT will ask you to input data every time you repeat the loop 
(usually more than 100 times). To avoid this and to avoid redundant programming (IF 
FIRSTTIME THEN ...), use the function GINPUT (general input), which will ask you 
for input data only the first time when you enter the loop.

INPUT variable

INPUT “string” variable

INPUT “string” variable = init value

Example:

b=1
MAX = 8
INPUT “Factorial of:” MAX

You will get the same effect if you use:

b=1
INPUT “Factorial of:” MAX = 8
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You will be asked to type a value in the Fractional Of box in the Input window.

Note: The initialization of MAX before INPUT is not necessary. If you delete the 
line MAX = 8, the default value in the Input box will be 0.

Example Ginput
GINPUT variable=init value

GINPUT “string” variable = init value

(general input)

Displays an Input window on the screen (text is optional).

If the whole program (User Defined Function) is running more than once in the logical 
(internal) block,

GINPUT will ask you to enter data only the first time the program runs.

Example:

If you define the following user function:

s=4
tanh(s*(x/Length))*(tanh (s*(1-x/Length)))

then the shape of the above function is controlled by the s parameter (assuming that 
x is a running

variable).

Now, if you want to test different shapes, with different s values, you will need to 
change the s value for each calculation. Instead of going through all dialog boxes and 
buttons to reach the User Function dialog box, whenever you want to change “s”.

Here comes the advantage of the GINPUT. You can use the GINPUT function:

GINPUT “Input Shape parameter” s=4
tanh(s*(x/Length))*(tanh (s*(1-x/Length)))

You will be asked to input different “s” values each time you press the Calculation 
button. Thus, you will be able to try different function shapes very quickly and easily.
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Predefined Constants

Mathematical constants
pi 3.14159265358979323846

e 2.71828182845904523536

Physical constants
Symbol Value Units Meaning

_c 2.9979e8 m/s Speed of light in free space

_e 8.8542e-12 F/m Permittivity in free space

_mi 4*pi*10e-7 H/m Permeability in free space

_q 1.60219e-19 C Elementary charge

_me 9.1095e-31 kg Free electron mass

_u 1.660531e-27 kg Atomic mass unit

_mp 1.672614e-27 kg Proton rest mass

_mn 1.674920e-27 kg Neutron rest mass

_eV 1.60219e-19 J Energy unit (electron-volt)

_h 6.626e-34 J s Planck constant

_hr 1.05459 e-34 Js Reduced Planck Constant

_lc 2.4263096e-12 m Compton wavelength of electron

_Ry 13.6058 eV Rydberg energy

_ri 1.09737312e7 1/m Rydberg constant

_kT 25.853 meV Thermal energy

_NA 6.022045e23 1 Avogadro number

_f 9.648 6e4 C/mol Faraday constant

_a 7.297351e-3 1 Fine structure constant

_a0 5.291771e-11 m Bohr radius

_re 2.817939e-15 m Electron radius

_mb 9.274096e-24 J/T Bohr magnetron

_kB 1.3807e-23 J/K Boltzmann constant

_sb 5.66961e-8 1 Stefan-Boltzmann constant
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Functions Library

Commonly used functions
sin(radian) sine

asin({0..1) radian

sinh(x) hyperbolic sine of x

cos(radian) {0..1}

acos({0..1}) radian

cosh(x) hyperbolic cosine of x

tan(radian) {0..inf}

atan({0..1}) radian

exp(x) e^x

ln(x) log in base e

log(x) log in base 10

deg(rad) radians into degrees

rad(deg) degrees into radians

fact(x) factorial x!

sqrt(x) square root of x

Other functions
min(a,b) =a if a<b else b

max(a,b) =a if a>b else b

comb(n, k)= number of combinations for k object, n - total number of objects (n>=m), 
return 0 if error

perm(m, n) =permutation mPn (0 if error)

gcd(a, b) = Greatest Common Divisor between a & b

lcm(a, b) = Largest Common Multiple between a & b

frc(x) = fractional part of 'x'

int(x) = integer part of 'x'

angle(x,y) Computes angle from Cartesian position (x,y), angle defined positive if y 
>0 and negative if y <0

rand(MaxNum) => Randomize {0..MaxNum}
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Fresnel integral
fresnel_s(x) = Fresnel Integral SIN

fresnel_c(x) = Fresnel Integral COS

Evaluates the Fresnel integrals

f(x), g(x)

fresnel_f(x) = function f(x) related to the Fresnel Integral

fresnel_g(x) = function g(x) related to the Fresnel Integral

Evaluates the functions f(x) and g(x) related to the Fresnel integrals by means of the 
formulae

Gamma function
Computes the value of the gamma function at x

(27)

(28)

(29)

(30)

S x( ) π
2
---t2
 
 sin td

o

x

∫=

C x( ) π
2
---t2
 
 cos td

o

x

∫=

f x( ) 1 2⁄ S x( )–{ } πx2 2⁄( ) 1 2⁄ C x( )–{ } πx2 2⁄( )sin–cos=

g x( ) 1 2⁄ C x( )–{ } πx2 2⁄( ) 1 2⁄ S x( )–{ } πx2 2⁄( )sin–cos=
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gamma(x) Gamma Function

lgamma(x) Natural logarithm of Gamma Function, x - must be positive

Error function
erf(x) error function

erfc(x) complementary error function

Computes the error function erf(x) and Complementary error function erfc(x):

 

When x>26 then erf(x)=1 and erfc(x)=0

When x< -5.5 then erf(x)=-1 and erfc(x)=2;

nexperfc computes 

i.e.

Inverse error function y(x):

(31)

(32)

(33)

(34)

Γ x( ) tx 1– e t– td
0

00

∫=

erf x( ) 2
π

------- e t2– td
0

x

∫=

erfc x( ) 2
π

------- e t2– td
x

00

∫=

x2( )∗erfc x( )exp

n erfc x( )exp 2ex2

π
---------- e t2– td

x

00

∫=
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inverf(x,minx)

Evaluates the inverse error function y(x) where

x - it is necessary that -1 <x < 1

if |x| > 0.8 then value of x is not used in the procedure

minx if |x| <= 0.8 then value minx is not used in the procedure

if |x|> 0.8 then minx has to contain the value of 1-|x|.

In the case that |x| is in the neighborhood of 1, cancellation of digits take place in the 
calculation of 1-|x| 

If the value 1-|x| is known exactly from another source, then minx has to contain this 
value, which will give better results.

Bessel functions

Bessel functions J

bessj0(x) - Bessel function J0(x) of the 1st kind of order 0

bessj1(x) - Bessel function J1(x) of the 1st kind of order 1

bessj [k] (x) - Bessel function Jk(x) of the 1st kind in order k

Bessel functions Y (Weber's function )

bessy0(x) - Bessel function Y0(x) of the 2nd kind of order 0

bessy0(x) - Bessel function Y1(x) of the 2nd kind of order 1

bessy [k] (x) - Bessel function Yk(x) of the 2nd kind of order k

Modified Bessel functions I

bessi0(x) - Modified Bessel function I0(x) of the 1st kind of order 0

bessi1(x) - Modified Bessel function I1(x) of the 1st kind of order 1

bessi [k] (x) - Modified Bessel function Ik(x) of the 1st kind of order k

Modified Bessel functions K

bessk1(x) - Mod. Bessel function K0(x) of the third kind of order 0

(35)x 2
π

------- e t2– td
x

y x( )

∫=
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bessk1(x) - Mod. Bessel function K1(x) of the third kind of order 1

bessk [k] (x) - Mod. Bessel function Kk(x) of the third kind of order k

Spherical Bessel functions

spbessj[k](x) => Spherical Bessel funct. Jk+0.5(x)

Bessel functions of the second kind (Neumann's functions)

neumann(a,x) - Neumann function Ya(x) of the 2nd kind of order a

neumann1(a,x) - Neumann function Ya+1(x) of the 2nd kind of order a

Chebyshev polynomials

chepol(n,x) - Computes the value of the Chebyshev polynomial Tn(x)

(36)

(37)

T0 x( ) 1 T1 x( ), x= =

Ti x( ) 2xTi l– x( ) Ti 2– x( ) i,– 2 …n,= =
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Unit Conversions

Length conversions
ft_m(foot) foot to meter

yd_m(yard) yard to meter

in_m(inch) inches to meter

Temperature conversions
c_k(celsius) Celsius to Kelvin

fh_k(Fahrenheit) Fahrenheit to Kelvin

fh_c(Fahrenheit) Fahrenheit to Celsius

k_c(kelvin) Kelvin to Celsius

c_fh(celsius) Celsius to Fahrenheit

k_fh(kelvin) Kelvin to Fahrenheit

Other conversions
gal_l gal_l(gallon) gallon to liter

pt_l pt_l(pint) pint to liter

oz_l oz_l(oz) oz to liter

in3_l in3_l(cubInc) cubic inch to liter

l_m3 l_m3(liter) liter to cubic meter

pd_kg pd_kg(pound) pound to kilogram

phe phe(wavelength[ìm]) calculate Photon energy [eV]
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NOTES:
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Appendix B - Fiber Mode Solvers

Introduction
Many kinds of optical fiber can be described, or in the case of graded index fibers, 
approximated by, a series of concentric layers of loss-less dielectric.  When the index 
contrast in the structure is small, it is common to use the scalar wave equation to 
obtain the linearly-polarized modes (LP modes).  However, when the index contrast 
becomes larger, the LP approximation becomes inaccurate, and a full vector analysis 
is necessary [1].  Within any one of the concentric layers, the field components are all 
linear combinations of Ordinary and Modified Bessel functions, and the solution is a 
matter of matching the tangential field components of adjacent layers, leading to the 
solution of a linear system.  There are some choices to make about the best way to 
arrange the linear system (see Ref. [2] for a complete treatment) but probably the best 
choice for a general, quick algorithm is the method of Yeh and Lindgren [3].  The 
method has intuitive appeal in its similarity to the transfer matrix method used for the 
analysis of planar waveguides [4].  Both methods use a matrix to express the fields at 
one side of a layer given their values at the other side, and the whole structure is then 
characterized by cascading the layers by matrix multiplication.  For vector fields in 
fibers, there is no natural separation into TE and TM polarization, so one must include 
the two tangential components for both electric and magnetic field simultaneously.   In 
total there are four transverse components at the layer boundaries, so the transfer 
matrix in fiber is a 4x4 matrix, instead of 2x2.

The method used by the Optiwave fiber mode solvers is different from the previous 
works in three ways.  The 4x4 matrix method for vector modes in fibers is 
implemented with these improvements to make the algorithm faster in execution time, 
and more reliable in the finding of modes, particularly in cases where the modes are 
almost degenerate.  The first improvement involves a reformulation of the basic 
equations to make a real-valued numerical implementation.  Since it is loss-less 
modes on a fiber of loss-less material that is being sought, there is no reason to 
include complex numbers in the formulation.  Real-valued implementation uses less 
computer resources.  Second, the complete transfer across one layer boundary 
requires a matrix inverse.  It is better to find this inverse analytically, rather than rely 
on numerical inversion at each stage.  The layer matrix can be decomposed into two 
4x4 matrices, and the new matrices are of a form where it is easy to find the inverse 
by inspection, thereby finding the analytic solution to the original inversion problem.  
Third, it is usual to construct the dispersion function (the zeros of which are located at 
the modal indices) as the determinant of the 4x4 matrix system.  While this is 
theoretically correct, it is not the most intuitive prescription.  Worse, the determinant 



is not the most convenient construction for locating the zeros, particularly in the case 
where two zeros are very close to each other.  Optiwave uses an eigen-value analysis 
that splits the dispersion function into two functions.  This splitting resolves the almost 
degenerate pairs and helps the simple-minded computer algorithms to find the zeros 
of the dispersion function (i.e. the modes) more reliably.

Real-valued formulation
The time independent Maxwell curl equations with a positive time convention ( ) 
are

and the divergence equations are

The factor j does not suit the current purpose, so make the substitution

where  is the free space impedance, so that h and E have the same 
units. Then

where  . Eliminating the h gives the electric wave equation

Debye Potential
For finding electromagnetic fields in a cylindrical geometry it is convenient to use 
cylindrical coordinates r,  and z, and Debye potentials parallel to the axis of rotation,

[2]

(1)

(2)

(3)

(4)

(5)

(6)

(7)

ejωt

E∇× jωµ0H–= H∇× jωε 0εE=

∇ εE( )⋅ 0= ∇ H⋅ 0 =

h jη0H–=

η0 µ0 ε⁄ 0=

E∇× kh= h∇× kεE=

k ω µ0ε 0=

∇ ∇ E k2–×× εE 0=

θ

ẑ

E ∇ ẑψ( )× 1
kε
-----∇ ∇ ẑϕ( )××+=

h ∇ ẑϕ( )× 1
k
---∇ ∇ ẑψ( )××+=
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It is supposed that the permittivity is constant in the region in which the above 
equations apply.  The fibers are defined as a series of concentric layers of constant 
dielectric, so for the fiber mode solver, the region is the annulus between the layer 
boundaries. Equation 6 and Equation 7 are applied in a piecemeal way.  Strictly 
speaking, the ,  and  should have subscripts to indicate to which layer the 
solution applies, but they are dropped here to simplify the representation.  The 
complete solution for the multilayer fiber will be constructed by using a separate pair 
of functions for each layer, and by matching the tangential field components at the 
layer boundaries

The divergence of the curl of any vector field is identically zero.  Therefore the choice 
of (6) and (7) to represent the electric and magnetic fields means that the divergence 
equations (2) will automatically be satisfied.  In the remainder of this section, we show 
that if the two potentials  and  are solutions to the scalar Helmholtz equation, then 
(6) will be a solution to the Maxwell wave equation (5), at least within any given layer.  
In subsequent sections, the particular solution for the mode will be found by observing 
the boundary conditions imposed by physical considerations on E and h.

Suppose  is a continuous function of position that satisfies the Helmholtz equation 
in 3 dimensions

Consider the following equation, true for any  satisfying (9) in a region of constant 
permittivity.

Associate the first two terms together and apply the vector identity

to get

The right hand side of (11) is a gradient of a scalar function, so the curl of the left hand 
side must be zero. take the curl of (11)

(8)

(9)

(10)

(11)

(12)

ψ ϕ ε

ψ ϕ

ψ

∇2ψ k2εψ+ 0=

ψ

∇ ∇ ẑψ( )⋅[ ] ∇2 ẑψ( )– k2εẑψ– ∇∂ψ
∂z
-------=

∇ ∇ ⋅( ) ∇2 ∇ ∇ ××=–

∇ ∇ ẑψ( )×× k2εẑψ– ∇∂ψ
∂z
-------=

∇ ∇ ∇ ẑψ( ) k2ε∇ ẑψ( )×–××× 0=
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and define E by the first term of (6). With E defined this way, the Maxwell electric 
wave equation (5) follows, and therefore this E is a possible solution for electric field.

Solutions defined from the  function solely (that is to say, solutions with  = 0), will 
have electric fields of the form

from which we can see there is no longitudinal (z) component to the electric field, i.e. 
these are transverse electric fields. The magnetic field associated with these 
transverse electric fields is constructed from the first Maxwell curl equation in (4):

which is the second term of (7).

The same sequence (7) - (11) can be applied to the  function to give transverse 
magnetic fields, and the electric components of these are given as the second term 
of (6).  A linear superposition of transverse magnetic and transverse electric fields will 
give solutions that are neither transverse magnetic nor transverse electric.  In fact, 
most modes of the fiber are of this hybrid kind.  In the hybrid case, equations (6) and 
(7) are used as written, and the relative value of the  and  is now important, since 
it is a specific linear combination that matches the boundary conditions at the layer 
boundaries.

Separation of Variables
The potentials themselves are solutions of the scalar Helmholtz equation, and the 
particular solution is found by observing the boundary conditions imposed by physical 
considerations on E and h.  The potentials are supposed to form modes, so a solution 
where the variables are separated is appropriate

and a similar expression applies for the other Debye potential, . The Helmholtz 
equation (8) is expanded in cylindrical co-ordinates, and then (15) is substituted.For 
regions where  is constant, the radial functions follow the Ordinary or Modified 
Bessel equation, and so the solutions are linear combinations of Bessel functions of 
integer order v. In any given layer,

(13)

(14)

(15)

(16)

ψ ϕ

E ∇ ψẑ( ) r̂
r
--=× ∂ψ
∂θ
------- θ̂∂ψ

∂r
-------–=

h 1
k
---∇ ∇ ẑψ( )××=

ϕ

ψ ϕ

ψ r θ z, ,( ) ψν r( ) j νθ βz–( )[ ]exp=

ϕ

ε

ϕν r( ) AJν ur( ) BYν ur( )+= ψν r( ) CJν ur( ) DYν ur( )+=
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where . In layers where the propagation constant squared is 
larger than , the Bessel functions J and Y are replaced by the Modified Bessel 
functions I and K, respectively.,

where . Equations (15), (16), and (17) are substituted in (6) and (7) 
to find the electromagnetic fields. It is the tangential components  and z that are 
needed explicitly, since it is the tangential components of the electric and magnetic 
fields that should match at layer boundaries. These field components are related to 
the coefficients A, B, C, and D by a 4x4 matrix

where  is the modal index, and the common factor  is 
suppressed. In layers where the propagation constant squared is larger than , the 
Bessel functions J and Y are replaced by the Modified Bessel functions I and K, 
respectively, and the u is replaced by w.

A similar equation to (18) applies in adjacent layers, with different constants A, B, C, 
D.  Given the constants in one layer, the constants in the adjacent layer can be found 
by solving the linear system created by the field matching condition. The f found by 
the two matrices should be the same field vector at the boundary between layers.  The 
difference between this formulation and that in Ref. [2] and [3] is that this formulation 
uses real numbers only.

Solution of the linear system
The order of the components in the vector f is chosen to help factor the matrix in (9) 
into two matrices as Ff = Dc where  ,

(17)

(18)

(19)

u k2ε β2–=
k2ε

ϕν r( ) AIν wr( ) BKν ur( )+= ψν r( ) CIν ur( ) DKν ur( )+=

w β2 k2ε–=
θ

f

Ez

hθ

hz

Eθ

u2Jν ur( ) kε⁄ u2Yν ur( ) kε⁄ 0 0
uJ'ν ur( )– uY'ν ur( )– nνJν ur( ) r⁄ nνYν ur( ) r⁄

0 0 u2Jν ur( ) k⁄ u2Yν ur( ) k⁄
nνJν ur( ) εr⁄ nνYν ur( ) εr⁄ uJ'ν ur( )– uY'ν ur( )–

A
B
C
D

= =

n β k⁄= j νθ βz–( )[ ]exp
k2ε

c A B C D, , ,[ ]T=

F

ε 0 0 0
0 1– nνk ru2⁄ 0
0 0 1 0

nνk ru2⁄ 0 0 1–

=
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The advantage of this factoring is that it is easy to find the expressions for  and 
.  is found by two row reductions and  by inverting the 2x2 matrices in the 

block diagonal. These matrices are required to find the coefficients in the next layer. 
If  are the coefficients in the m-th layer, then the coefficients in the next layer is 
found from the matrix product,

The use of the factored matrix means four matrix multiplications instead of two are 
required to cross the boundary, but it avoids having to find the matrix inverse 
numerically.

Dispersion equation
The matrix to describe the whole multilayer can be written as one 4x4 matrix, the 
product of all layers, one layer of which is shown in (21).  The dispersion equation is 
usually constructed by setting the determinant of this 4x4 matrix product to 0, but this 
is not a good choice from the numerical point of view.  In the limit of low index contrast, 
the modal indices can be very close to each other, making them hard to find by 
numerical methods, which tend to skip over closely spaced zeros. A more convenient 
condition comes from using rectangular matrices at the first and last layers, which are 
special cases.  In the first layer, which contains r = 0, coefficients  and  must 
be zero, so the first matrix, , is 4 x 2 consisting of the first and third columns of the 
D matrix in (20).  Similarly, in the last layer, it is the coefficients  and  that must 
go to zero in (17), since those contain solutions  with unphysical growth.  The last 
matrix  will be of size 2 x 4, and consist of the first and third rows of .  The 
product of all these matrices will be of size 2x2, which we call S(n). (The dependence 
on n is written explicitly since it is the modal index to be found). A mode is obtained 
at a modal index n when a non-trivial solution is found to,

The condition det(S) = 0 is sufficient for a non-trivial solution. However this condition 
can be inconvenient for the case of certain modes of the low index contrast fiber. For 
example, consider a step index fiber with radius 2 , having a core index of 1.46 
and a cladding of 1.45. For order zero ( ), the determinant of S will vary with 
the modal index n as shown in Figure 1.

(20)

(21)

(22)

D

u2Jν k⁄ u2Yν k⁄ 0 0
uJ'ν uY'ν 0 0

0 0 u2Jν k⁄ u2Yν k⁄
0 0 uJ'ν uY'ν

=

F 1–

D 1– F 1– D 1–

cm

cm 1+ Dm 1+
1– rm( )Fm 1+ rm( )Fm

1– rm( )Dm rm( )cm=

B0 D0
D0

AM CM
Iν

DM
1– D 1–

0 S n( ) A0

C0

=

µm
ν 0=
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Figure 1 The determinant of the system matrix vs. the modal index. Step index fiber with radius 2 , core 
index of 1.46, and a cladding of 1.45. The optical wavelength is 0.5 , and the order .

It is difficult to find the zero for curves of this type. The position of the zero is easily 
passed over in the initial search for zero crossings. The shape of the curve in the 
region of the zero is very nearly quadratic, so the best solution is to split the 
determinant function into a product of two functions. In that case, the zeros can be 
found by looking for zero crossings of the two functions separately. Suitable functions 
can be found by considering the vector , as an eigenvector of S with 
eigenvalue, equal to 0. The eigenvalues of S(n) are ,

Where . The determinant  of a matrix is equal to the product of its 
eigenvalues, so the product  is a factoring convenient for 
the zero finding task. A mode exists when either  or . The 
advantage of searching for zeros of the two functions (23) is that the functions  
and have zeros that are widely spaced apart, and are more easily found than 
the zeros of the single determinant function.

(23)

µm
µm ν 0=

A0 C0,[ ]T

λ

λ1 n( ) T 2⁄ T2 4⁄ det S( )–+= λ2 n( ) T 2⁄ T2 4⁄ det S( )––=

T S11 S22+=
det S n( )( ) λ1 n( )λ2 n( )=

λ1 n( ) 0= λ2 n( ) 0=
λ1 n( )

λ2 n( )
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Figure 2 Plot of the eigenvalues and determinant vs modal index.

Figure 3 Expanded view of the zero crossing region

LP Modes
Linearly Polarized modes can be found with the same style of approach as above, by 
a transfer matrix analysis of multilayer fibers.In the LP analysis, the initial excitation is 
assumed to have a linear polarization, and so a modal analysis supporting only one 
field component is used. It can be shown this is a good approximation for fibers with 
low refractive index contrast, as shown below.
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Consider again the wave equation of (5), but this time use the vector identity (10) 
directly on the electric wave equation instead of introducing the Debye potential. The 
result is

From the Maxwell divergence equation (2)

so that

In the case of low index contrast waveguides, such as are found in most optical fibers, 
the last term in (26) is negligible. The last term is the only one that contributes to 
coupling among the field components of the electric field, so if this term is neglected, 
the model will be a polarization preserving model. If the excitation was a linear 
polarization parallel to the X axis, the model could be further simplified by considering 
only the X component of (26). This shows that for the LP model, the governing 
equation for the field is the Helmholtz equation (8) applied to the field component .

The solution for LP modes is constructed in a similar way as for the vector modes. 
The  is constructed in each layer as a linear combnation of Bessel functions (16) 
and (17), except this time only two coefficients,  and , are required, since only 
one function needs to be constructed. The physical consideration at the layer 
boundaries is the continuity of  and its derivative. The two conditions are related 
to the two coefficients A and B for each layer by 2x2 matrices. The modes are found 
by setting up a calculation that assumes  and  for the first (inner 
most) layer, and then calculating the coefficients in each subsequent layer by matrix 
manipulations.  The last layer has the condition that the coefficient ( ) of the Bessel 
function  must be zero, since this Bessel function is not bounded at infinity.  This 
last coefficient is a function of the order  and the modal index n, so the modes are 
found by finding the zeros of .

(24)

(25)

(26)

∇2E ∇ ∇ E⋅( )E– k2+ εE 0=
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  APPENDIX C - OPTI2D GRAPH CONTROL
Appendix C - Opti2D Graph Control

The Graph control is a versatile, powerful easy-to-use tool for observing data (see 
Figure 4). This section gives a brief description of some of the 2D graph control 
features and an explanation of how to use them.

Figure 4 Opti2D Graph Control
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User interface features

Information windows

There are two main windows visible on the main display:
• Info-window
• Info-Window settings dialog box

Both can be launched using the Graph menu or Graph tools.

Info-window

Figure 5 Info-window

Features Description

Large data handling capa-
bilities

Opti2D Graph control is capable of handling millions of points.

Optimized drawing Even with a large number of data points, Opti2D Graph Control is 
optimized to allow for smooth tracing and panning of graphs.

Moveable information win-
dows

Moveable information windows allows for placement of the win-
dows in the most convenient location in the graph window.

Crosshair Visible cross to make seeing trace points easier.

Graph toolbox The popup Graph toolbox allows easier access to the view-
ing/organizing/editing capabilities of the Opti2D Graph tool.

Graph Menu button The Graph menu button allows you to access a full list of function-
ality associated with the graphs and their data.
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When you access the Info-window, it displays in the work area of the graph view. By 
default, it displays the current position (in data-base coordinates) of the cursor. When 
you add marker, tracers, and regions, the Info-Window expands to show the details 
of these components.

When you use the Select tool, if you double click in the window, the Info-Window 
properties dialog displays (see Figure 6).

Figure 6 Info-Window settings dialog box

Legend

You can switch the Legend on and off using the Legend tool in the Graph toolbox, or 
the Graph menu. The Legend displays a list of all the curves displayed in the graph 
with the corresponding line color that is used to display those curves (see Figure 7). 
Use the Minimize/Maximize button to change the display of the Legend, or close the 
Legend by using the Close button.

Figure 7 Legend
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Graph toolbox

To access the Graph toolbox, right-click in the graph view. Most graph 
editing/viewing/organizing capabilities are accessible using the toolbox (see Figure 
8).

Figure 8 Popup Graph Toolbox

Graph tools

File menu item Toolbar 
button

Description

Select Allows you to manipulate and move most of the objects on the Graph.

Note: To edit the properties of an object, double-click the object in the 
graph view.

Zoom Zoom in: You can select a rectangular region, or click in the graph 
view for proportional zoom in.

Extra features:

•    Zoom out: Hold Ctrl and click to perform a zoom out.

•    Reset Zoom Level: Double-click in the graph view to return to the 
default Zoom level.

Pan If Allows you to pan from side to side in the graph display to see parts 
of the graph that may not be visible at the existing Zoom level or 
resolution.

To pan, click to grab the display, and move the cursor from side to 
side.

Extra Features:

•    If you press Ctrl while panning the graph display, accelerated pan 
is engaged, which makes the pan much faster. This feature is useful 
when you work under a high zoom factor.
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Grid Allows you to turn the grid lines on/off. Click on the Grid tool to toggle 
the grid lines.

Tracer Allows you to select a curve and trace over it while viewing the exact 
positional values on the curve in the Info Window. To select a different 
curve, double click in graph view.

Extra Features:

•    You can freeze the tracer by pressing Ctrl. Click to place a marker 
on the curve at that position.

•    Press Shift and drag the cursor to put the tracer into a high-
resolution trace that iterates through each element in the source data 
array. This allows for a very detailed scan of the data and to find 
peaks that the standard trace may omit.

Trace Allows you to select a curve and trace over it while viewing the exact 
positional values on the curve in the Info Window. The Difference 
Tracer differs from the Tracer tool because it allows you to create a 
second tracer to compare values on either the same curve or on 
different curves. To select the next curve, double click on the curve in 
the graph view.

Extra Features:

•   By Pressing the Control Key the tracer will freeze in its present 
position. Then by pressing the left mouse button a marker will be 
placed on that position on the curve.

•   By pressing the shift key and dragging the mouse the tracer jumps 
into a high-resolution trace that iterates through each element into the 
source data array. This allows for a very detailed scan of the data and 
to find peaks that the standard trace may omit.

Marker Allows you to place markers in the active graph view. The markers 
can be horizontal, vertical or both. The position of the markers is 
displayed in the Info Window.

Region Allows you to select a horizontal, vertical or rectangular region in the 
active graph view. The coordinates of the selection are displayed in 
the Info Window.

File menu item Toolbar 
button

Description
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Label Allows you to place customized labels in the active graph view.

Legend Allows you to toggle the Legend on and off within the active graph 
view.

Info Allows you to toggle the Info-Window on and off within the active 
graph view.

Layout Allows you to reset the layout and place all windows in their default 
positions.

File menu item Toolbar 
button

Description
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Graph menu

To open the Graph menu, click the blue icon at the top left corner of the Graph view 
(see Figure 9).

Figure 9 Graph Menu

Graph Menu button

The Graph Menu button is in the top left corner of the graph view.

Tools

The tools available from the Graph menu include:
• • Select
• • Zoom
• • Pan
• • Grid
• • Tracer
• • Difference Tracer
• • Marker
• • Region
• • Label
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Windows

The information windows available in the Graph Menu include:
• • Legend
• • Info Window
• • Reset Layout

Printing and exporting files

Print

Opens the Print dialog box and allows you to print an image of the active graph view 
(see Figure 10).

Figure 10 Print dialog box

Print to BMP file

Exports an image of the active graph view to a file in .bmp format using the Save As 
dialog box (see Figure 11).
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Figure 11 Print to BPM File

Print to EMF file

Exports an image of the active graph view to a file in .emf format using the Save As 
dialog box (see Figure 12).

Figure 12 Print to EMF File

Copy image to clipboard

Copies an image of the active graph view to the clipboard.
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Utilities

Tool setup

Allows you to modify the properties of some of the tools.

Note: The tool property dialog only launches if the active tool allows settings to 
be changed.

Set Active Display

Allows you to select the active display. For more information, see “Displays” on page 
231.

Properties

Allows you to launch the Graph Properties dialog. For more information, see For more 
information, see “Graph display” on page 232.

Table of Points

Launches a dialog box that displays a list of all the curves on the graph control and 
displays the data coordinates of those curves. It also allows you to export the data 
points to a text file (see Figure 13).

Figure 13 Data Table dialog box

Help

Launches a help dialog box specifically related to the Opti2D Graph Control.
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Import Curve

Allows you to import a curve from a text file. The file must be in the format below.

X1 (tab) Y1

X2 (tab) Y2

Etc…

Ex:

// (Beginning of file) (this line should not be in the file)

123.23  123.45

123.24  124.55

123.25  555.5

123.26 222.22

//(End of file) (this line should not be in the file)

Displays

The graph is made up of layered displays. Each display has a pair of axes. By default, 
the control contains one display with Axis X on the bottom of the display and Axis Y 
on the left. In the case of complex graphs that require more than one pair of axes, 
more than one display exists (see Figure 14).

Figure 14 Active Display dialog box
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Any objects that you place on the graph are placed on the active graph view. 
Therefore, if you place a marker on the graph and Display 1 is active, the new marker 
is based on the coordinate system of Display 1. If you want to add a marker on Display 
2, you must select the main menu in the Graph menu. This launches the Graph 
Display dialog, which permits you to select a different display. In complex graphs, the 
displays are layered one on top of the other (see Figure 15).

Figure 15 Graph display

Graph Properties dialog

The Graph Properties dialog allows you to manage properties of the graph.

The Graph Properties dialog tabs include:
• X-Axis
• Y-Axis
• Properties dialog box-Y-Axix tab
• Grid
• Fonts
• Legend
• Properties dialog box-Legend tab
• Label Management

X-Axis

The X-Axis Tab allows you to set properties of the X-axis (see Figure 16).
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Figure 16 Properties dialog box-X-Axis tab

The values in Scale Type can be:
• Linear
• Logarithmic
• DB
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The values in Format Value can be:
• Decimal: simple decimal values (1000.0, 2000.0, 3000.0)
• Exponential: exponential notation (1.0-e3, 2.0-e3, 3.0-e3)
• Engineering: engineering notation (1k, 2k, 3k)
• Scientific: scientific notation (1.0 x 103,2.0 x 103, 3.0 x 103)

Prefix: You can place a prefix string before each of the scale values.

Suffix: You can place a suffix string after each of the scale values (e.g. 1000.0 nm)

Automatic Range, Min Value, Max Value: You can check Automatic Range, which 
sets the range according to the curves in the displays, or force the axis range to 
certain values.

Tickmarks: You can set the number of major and minor tick marks on the Axis.

Y-Axis

The Y-Axis Tab allows you to set properties of the Y-axis (see Figure 17). To see 
descriptions of the Y-Axis dialog fields, see “X-Axis” on page 196.

Figure 17 Properties dialog box-Y-Axix tab
234



  APPENDIX C - OPTI2D GRAPH CONTROL
Curve

The Curve tab allows you to set various properties of the curves that are added to the 
control (see Figure 18).

Figure 18 Properties dialog box-Curves tab

Curve List: Displays all of the curves on the active display.

Curve Properties

Color: Allows you to choose the color of the selected curve.

Line Style: Allows you to select the line style of the selected curve.

Plot Style: Allows you to select the plot style.

The values in Plot Style can be:
• Point
• Line
• Segment Left
• Segment Right
• Segment Center
• Step Left
• Step Right
• Drop Line
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Line Thickness: Allows you to select the thickness of the currently plotted curve line. 
Values range from 1 to 8.

Point Style: Allows you to select the style in which each point on the curve will be 
drawn.

The values in Point Style can be:
• None
• Circle
• Square
• Diamond
• Cross

Grid

The Grid tab allows you to select which of the grid lines on the display are visible, and 
what color they are to be displayed in (see Figure 19).

Figure 19 Properties dialog box-Grid tab
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Fonts

The Font Tab allows you to select the fonts used for displaying titles and axis values. 
(see Figure 20).

Figure 20 Properties dialog box-Fonts tab

Legend

Legend tab simply has a toggle for the Legend Visible/Invisible. More features will 
become available in the future (see Figure 21).
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Figure 21 Properties dialog box-Legend tab

Graph

The Graph tab is used for editing the titles of any axis as well as the graph title itself 
(see Figure 22).

Figure 22 Properties dialog box-Graph tab
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Label Management

The Label Management tab allows you to remove and edit labels on the graph. You 
can also access the Label Management function using the Label tool in the Graph 
toolbox (refer to Figure 23).

Note: For removing a large number of labels or labels that may have been 
positioned at coordinates that are not in the viewable area, it is easier to remove 
or edit them using the Label Management tab, because of the multiple selection 
feature.

Figure 23 Properties dialog box-Label Management tab

Use the Label Properties dialog box to edit the name or coordinates of the selected 
label (see Figure 24).

Figure 24 Label Properties dialog box
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Appendix D - File Formats

Generic file format

The Generic file format is a text format that consists of three data columns, X, Y, and 
Z, separated by space (see Table 1).

Note: This format is one of the export formats. It is not supported by any of the 
viewers.

Data file formats

Optiwave software uses the text data format for saving the simulation results and 
reading user defined fields and index of refraction distributions:
• Real Data 2D File Format: BCF2DPC
• Real Data 3D File Format: BCF3DPC
• Complex Data 2D File Format: BCF2DCX
• Complex Data 3D File Format: BCF3DCX
• User Refractive Index Distribution File Format

Table 1: Generic file format

X Y Z

1 1 1

X Y Z

2 2 2

X Y Z

3 3 3

.. .. ..

. . .

X Y Z

N N N
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Optiwave software uses several different formatted text files for reading and saving 
optical fields and index of refraction distributions.

Real Data 2D File Format: BCF2DPC

Applies to input and output files that contain real data as text. The file contains the file 
header, number of data points, and the real x and y data points:

Files that follow the BCF2DPC format
• Output files in 2D: [*.rpd], [*.poi]
• Output files in 3D: [*.rpd], [*.poi]

Example: Power overlap integral output file in 2D [*.poi]

In this example, a Gaussian input field is propagated in a Linear Waveguide from the 
starting distance 0.000000E+000 to the end distance 1.000000E-001. The 
propagating field is overlapped with the starting field, giving the power overlap value 
1.000000E+000 at the start and the value 4.034535E-001 at the end of propagation. 
The number of displays in the Global Data dialog box is 30, while the actual number 
of saved data points is 31. This is, because the file contains also the power overlap 
value at the start of propagation in addition to 30 values from the propagation.

BCF2DPC file header (this string is used to identify the file type)

N number of data points

X1 Y1 first x and y data separated by space

X2 Y2 second x and y data point

.

.

.

XN YN last x and y data point

BCF2DPC file header

31 number of data points

0.000000E+000
1.000000E+000

start distance and power overlap at start

3.3300000E-003 3.558430E-001 distance and power overlap

6.670000E-003 3.663763E-001 distance and power overlap

.
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Real Data 3D File Format: BCF3DPC

This format applies to input and output files that contain real data as text. The file 
contains the file header, number of x and y data points, minimum and maximum 
values of x, y and z, and the real z(x,y) data points. The data points are presented in 
one column with the order determined by scanning the x and y coordinates.

where dx = (xmax-xmin)/(nx-1) and dy = (ymax-ymin)/(ny-1).

Files that follow the BCF3DPC format
• Output files in 2D: [*.amp], [*.pha], [*.rri]
• Output files in 3D: [*-x.amp], [*-y.amp], [*-x.pha], [*-y.pha], [*-x.rri], [*-y.rri]

For more information, see Data file formats.

.

.

9.333000E-002 4.039581E-001 distance and power overlap

9.667000E-002 4.038129E-001 distance and power overlap

1.000000E-001 4.034535E-001 end distance and power overlap

BCF3DPC file header

NX NY number of x and y data points 

XMIN XMAX minimum and maximum x values

YMIN YMAX minimum and maximum y values

ZMIN ZMAX minimum and maximum z values

Z1 real z data point with coordinates (xmin, ymin)

Z2 real z data point with coordinates (xmin+dx, ymin)

Z3 real z data point with coordinates (xmin+2dx, ymin)

.

ZNX real z data point with coordinates (xmax, ymin)

ZNX+1 real z data point with coordinates (xmin, ymin+dy)

.

.

ZN last real z data point with coordinates (xmax, 
ymax), where N=NXxNY
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Example: Real refractive index in 2D [*.rri]

In this example, the transverse mesh extends from -5.000000E+000 to 
5.000000E+000 microns. The propagation distance extends from 0.000000E+000 to 
1.000000E-001 millimeters. A Linear Waveguide with refractive index 1.5 is laid out 
on a wafer with the index 1.3. The number of mesh points is 100 and the number of 
displays in the Global Data dialog box is 30. The actual y number of saved index x 
distributions is 31. This is, because the file contains also the index distribution at the 
start of propagation in addition to 30 values from the propagation.

Complex Data 2D File Format: BCF2DCX

This format applies to input and output files that contain complex number data as text. 
The file contains the file header, number of data points, mesh width, and the complex 
z data points:

BCF3DPC file header

100 31 number of x and y data points

-5.000000E+000 5.000000E+000 minimum and maximum transverse 
mesh values

0.000000E+000 1.000000E-001 minimum and maximum distance

0.000000E+000 1.000000E+000 unused values added to conform to 
the format
Note: Optiwave software adds a line 
of default values 0 and 1 to conform 
this format.

1.300000E+000 real z data point with coordinates 
(xmin, ymin)

1.300000E+000

1.300000E+000

.

.

.

1.300000E+000

1.300000E+000

1.300000E+000
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New format

Files that follow the BCF2DCX format
• Output files in 2D: [*.f2d]

For more information, see Data file formats.

Example: Complex field (end of propagation) in 2D [*.f2d]

In this example, the number of data points, that is, the number of mesh points is 100. 
The transverse mesh extends from -5.000000E+000 to 5.000000E+000 microns 
giving the mesh width 1.000000E+001 microns.

BCF2DCX 3.0 file header

N number of data points

Xmin Xmax minimum and maximum of x values

Z1 first complex data point

Z2 second complex data point

.

.

.

ZN last complex data point

BCF2DCX

100

1.000000E+001 3.000000E+001

-1.625361825110615E-003, -4.389245939619818E-004

-1.509141347436203E-003, -5.157781413025380E-001

1.396612427100470E-003, 5.882450646580990E-004

.

.

.

1.396612427102228E-003, -5.882450646589938E-004

-1.509141347437384E-003, -5.157781413024150E-004
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Complex Data 3D File Format: BCF3DCX

This format applies to input and output files that contain complex data as text. The file 
contains the file header, number of x and y data points, mesh widths in x and y, and 
the complex z(x,y) data points. The data points are presented in one column with the 
order determined by scanning the x and y coordinates.

New format

where dx = (xmax-xmin)/(nx-1) and dy = (ymax-ymin)/(ny-1).

Example: Complex field (end of propagation) in 3D [*.f3d]

In this example, the number of data points is 100 and equals to the number of mesh 
points. The transverse mesh extends from -5.000000E+000 to 5.000000E+000 
microns giving the mesh width 1.000000E+001 microns.

BCF3DCX 3.0

100 100

-1.625361825110870E-003, -4.389245939610474E-004

BCF3DCX 3.0 file header

NX NY number of x and y data points

Xmin Xmax Ymin Ymax minimum and maximum x and y values

Z1 complex number z data point with coordinates 
(xmin, ymin)

Z2 complex number z data point with coordinates 
(xmin+dx, ymin)

Z3 complex number z data point with coordinates 
(xmin+2dx, ymin)

.

ZNX complex number z data point with coordinates 
(xmax, ymin)

ZNX+1 complex number z data point with coordinates 
(xmin, ymin+dy)

.

.

ZN last complex number z data point with coordinates 
(xmax, ymax), N=NXxNY
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1.000000E+001 1.100000E+001 2.000000 E+001 3.000000 E+001

Files that follow the BCF3DCX format
• Output files in 3D: [*.f3d]

For more information, see Data file formats.

-4.582487025358980E-004, -2.411965546811583E-002

1.813879122411751E-004, -2.322439514101689E-002

8.864140535377826E-004, -2.245463661588051E-002

.

.

.

-1.004141897700716E-002, 7.709994296904761E-003

-9.736326254112302E-003, 8.732395427319460E-003

-9.270032367315658E-003, 9.686774052240091E-003
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User Refractive Index Distribution File Format

Default format for 3D Refractive Index Distribution

UPI2DRI 3.0 file header

NPM number of points in mesh

XMIN XMAX min and max mesh points

Z1 first complex number data point

Z2 second complex number data point

.

.

.

ZN last complex number data point

Example

UPIDRI 3.0

500

-50 50

1.491000000000000E+000, 0.000000000000000E+000

1.491000000000000E+000, 0.000000000000000E+000

.

.

.

1.491000000000000E+000, 0.000000000000000E+000

UPI3DRI 3.0 file header

NPMX NPMY number of points in mesh in X and Y

Xmin Xmax Ymin Ymax min and max mesh points in X and Y

Z1 first complex number data point

Z2 second complex number data point

.
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Reading User Refractive Index Files

During the propagation, the Optiwave software simulator reads the index distribution 
file in a step by step manner. The information for reading the user data file is provided 
by the Device Layout Designer and it concerns the number of mesh points and the 
extent of the User Defined File Region.

If the refractive index distribution as defined by the properties of the region is 
independent of the propagation distance (i.e. constant), then the simulator reads the 
index data only once, for the first step of propagation in the region and uses the same 
data for every step in that region.

If the refractive index distribution is defined as propagation dependent, then the 
propagation enters the User Defined File Region, the program reads index of 
refraction data for each propagation step. The number of lines that is read at one step 
is equal to the number of transverse mesh points.

For more information, see Data file formats.

Complex Data 3D Vectorial File Format: BCF3DCXV

This format applies to input and output files that contain vectorial complex data. The 
file contains the file header, number of x and y data points, mesh widths in x and y, 
and the complex z(x,y) data points both for Ex and Ey field components. The data 
points are presented in one column with the order determined by scanning the x and 
y coordinates.

.

.

ZN last complex number data point

Example

UPI3DRI 3.0

151 121

-7.5 7.5 -3 3

3.300000000000000E+000, 0.000000000000000E+000

3.300000000000000E+000, 0.000000000000000E+000

.

.

.

3.250000000000000E+000, 0.000000000000000E+000
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BCF3DCXV file header

Nx Ny number of x and y mesh points

Xmin Xmax Ymin Ymax minimum and maximum X and Y coordinates

Za1 complex field (Ex field component) at point with 
coordinates (xmin, ymin)

Za2 complex field (Ex field component) at point with 
coordinates (xmin+dx, ymin)

Za3 complex field (Ex field component) at point with 
coordinates (xmin+2dx, ymin)

.

ZaNX complex field (Ex field component) at point with 
coordinates (xmax, ymin)

ZaNX+1 complex field (Ex field component) at point with 
coordinates (xmin, ymin+dy)

.

.

ZaN (N=Nx*Ny) complex field (Ex field component) at point with 
coordinates (xmax, ymax)

Zb1 complex field (Ey field component) at point with 
coordinates (xmin, ymin)

Zb2 complex field (Ey field component) at point with 
coordinates (xmin+dx, ymin)

Zb3 complex field (Ey field component) at point with 
coordinates (xmin+2dx, ymin)

.

ZbNX complex field (Ey field component) at point with 
coordinates (xmax, ymin)

ZbNX+1 complex field (Ey field component) at point with 
coordinates (xmin, ymin+dy)

.

.
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where N=Nx*Ny, dx=(xmax-xmin)/(Nx-1), and dy=(ymax-ymin)/(Ny-1).

Note: The total number of data points is twice the number of the total mesh points 
Nt=2*N.

Path Monitoring File Format

The sample is provided (*.mon):

BCF2DPM

Power In Output Waveguides File Format

The sample is provided (*.piw)

ZbN (N=Nx*Ny) complex field (Ey field component) at point with 
coordinates (xmax, ymax)

Npts NPath Number of data points (lines) and number of paths

[Distance] [Path 1] [Path 2] [Path 3] ...[Path NPath] text 
discriptor

XCoord 1 P1val1 P2val1 P3val1 …. PNPathval1

XCoord 2 P1val2 P2val2 P3val2 …. PNPathval1

...

XCoord NPts P1valNPts P2valNPts P3valNPts …. PNvalNPts
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BCF2DMC

NPts WGN Number of data points (lines) and number of waveguides

[Wavelen] [ WG1 ] [ WG2 ] [ WG3 ] …. [ WGWGN] text

descriptor

XCoord1 P1val1 P2val1 P3val1 …. PWGNval1

XCoord2 P1val2 P2val2 P3val2 …. PWGNval2

...

XCoordNPts P1valNPts P2valNPts P3valNPts …. PWGNvalNPts
252





Optiwave
7 Capella Court
Ottawa, Ontario, K2E 8A7, Canada

Tel.: 1.613.224.4700
Fax: 1.613.224.4706

E-mail: support@optiwave.com
URL: www.optiwave.com


	Table of Contents
	Introduction to OptiFiber
	Welcome
	What is OptiFiber?
	With OptiFiber the user can:
	What is new in OptiFiber version 2.0
	What is new in OptiFiber 2.1


	Installation
	Hardware requirements
	Software requirements
	Installation procedure
	Documentation
	Online Help
	Support
	Technical support
	Technical Support by Phone
	Technical Support by Fax
	Technical Support by E-mail
	Using Optiwave’s Web Page


	Getting Started with OptiFiber
	Learning Basic Features of OptiFiber
	Starting and exiting OptiFiber
	Looking at OptiFiber interface
	Using menu commands
	Using Standard toolbar commands
	Using Graph Tools toolbar commands
	Using Navigator pane
	Using Views window
	Managing projects


	Designing and Calculating with OptiFiber
	Designing a fiber profile
	Calculating fiber modes
	Calculating properties of fundamental mode
	Calculating properties of higher order mode
	Calculating properties of an arbitrarily selected group of modes
	Calculating cutoff wavelengths
	Calculating birefringence
	Calculating polarization mode dispersion

	Using Graph Tools
	Using “Joints” tool
	Using “Zoom” tools
	Using “Measure” tool
	Using “Tracking” tool
	Using “Legend” tool

	Technical Background
	Refractive Index of Fibers
	Fiber Propagation Modes
	Group Delay and Dispersion Definitions
	Mode Field Diameter and Mode Area Definitions
	Cutoff Wavelengths
	Fiber Loss Models
	Fiber Birefringence Models
	Polarization Mode Dispersion Models
	Technical References

	Tutorial Lessons
	Lesson 1: Designing Single Mode Fiber
	Defining fiber profile
	Defining dispersion models
	Calculating fiber modes
	Calculating cutoff wavelength
	Calculating properties of fundamental mode
	Viewing results
	Simulating polarization mode dispersion
	Birefringence
	Polarization mode dispersion

	Performance Characterization
	NOTES:


	Lesson 2: Characterizing A Real Fiber Sample
	Experimental procedures
	Importing the experimental profile
	Calculating the parameters of the fiber sample
	NOTES:


	Lesson 3: Designing Dispersion Shifted Fiber
	Defining fiber profile
	Finding the zero dispersion wavelength
	Optimizing profile for a required zero dispersion wavelength

	Lesson 4: Designing Dispersion Flattened Fiber
	Defining fiber profile
	Calculating the characteristics of the dispersion flattened fiber


	Commands Reference
	File Menu Commands
	New command
	Open command
	Close command
	Save command
	Save As
	Export Profile command
	Import Profile command
	Print command
	Print Preview command
	Print Setup command
	Recent Files command
	Exit command

	View Menu Commands
	Status Bar
	Navigator command
	Toolbars command
	Views command

	Fiber Menu Commands
	Profile command

	Simulation Menu Commands
	Modes command
	Fundamental Mode command
	Higher Order Modes command
	Cutoff command
	Birefringence command
	PMD command

	Tools Menu Commands
	Settings command
	Table command
	Calculated results command

	Window Menu Commands
	New Window command
	Cascade command
	Tile command
	Arrange Icons command
	List of Windows command

	Graph Tools Commands
	“Joints” command
	“Zoom XY” command
	“Zoom X” command
	“Zoom Off” command
	“Measure” distance command
	“Tracking” command
	“Legend” command
	“Grid X” command
	“Grid Y” command
	“X Cut” command
	“Y Cut” command

	Dialog Boxes Reference
	Fiber Profile Related Dialogs
	Select Profile Type dialog box
	Fiber Profile dialog box
	Info dialog box
	Material Properties dialog box
	Material Properties dialog box (Profile type is “Refractive Index” )
	Material Properties dialog box (Profile type is “Dopant Concentration” )

	Parameters of Material dialog box
	Sellmeier Formula

	Profile Function Parameters dialog box
	Gaussian Function Parameters dialog box
	Parabolic Layer Parameters
	Alpha Power Law Function Parameters dialog box
	User Defined Function dialog box
	Working with user defined functions
	The Editing Area
	The Display Area
	Working in the Editing Area
	Exploring the User Defined Function program editor
	Using Combo boxes
	Using the Display Steps box
	Running the Program and Debugging
	Exploring the Display Area
	The Progress check box
	The Load and Save buttons

	Refractive index profile preconditioning dialog
	Resolution step
	Low-pass FFT filtering / Averaging


	Fiber Modes Related Dialogs
	Modes dialog box
	Composition dialog box
	Linear decomposition of a given field distribution
	Properties of Fundamental Mode dialog box
	Properties of Higher Order Modes dialog box
	Cutoff dialog box

	Fiber Loss Related Dialogs
	Material Loss dialog box
	IR Absorption dialog box
	UV Absorption dialog box
	Rayleigh Scattering dialog box
	Bending Loss dialog box
	Splice Loss dialog box

	Fiber Birefringence Related Dialogs
	Birefringence dialog box

	Polarization Mode Dispersion Related Dialogs
	Polarization Mode Dispersion dialog box
	PMD dialog box

	Graph Related Dialogs
	Table dialog box
	Calculated results dialog box
	Graphic Properties dialog box

	Settings
	Global Settings dialog box

	Output Views Reference
	Profile view
	Modal Index view
	Group Delay view
	Dispersion view
	Mode Measures view
	Material Loss view
	Bending Loss view
	Splice Loss view
	Mode Field view
	Birefringence view
	PMD view
	Effective Nonlinear Refr. Index view


	Appendix A - Script Language Reference
	Overview of Script Language
	Variables, Arrays, and Operators
	Variables
	Arrays
	Mathematical Operators
	Boolean operators
	Comparison operators

	Commands and Statements
	Commands and statements
	RETURN command
	IF statement
	ERROR keyword
	FIRSTTIME keyword
	Input dialog box
	Example Input
	Example Ginput


	Predefined Constants
	Functions Library
	Unit Conversions

	Appendix B - Fiber Mode Solvers
	Introduction
	Real-valued formulation
	Debye Potential
	Separation of Variables
	Solution of the linear system
	Dispersion equation
	LP Modes
	References

	Appendix C - Opti2D Graph Control
	User interface features
	Information windows
	Info-window
	Legend
	Graph toolbox
	Graph tools
	Graph menu
	Graph Menu button
	Tools
	Windows
	Printing and exporting files
	Print
	Print to BMP file
	Print to EMF file
	Copy image to clipboard
	Utilities
	Tool setup
	Set Active Display
	Properties
	Table of Points
	Help
	Import Curve
	Displays
	Graph Properties dialog
	X-Axis
	Y-Axis
	Curve
	Curve Properties
	Grid
	Fonts
	Legend
	Graph
	Label Management

	Appendix D - File Formats
	Generic file format
	Data file formats
	Real Data 2D File Format: BCF2DPC
	Files that follow the BCF2DPC format
	Example: Power overlap integral output file in 2D [*.poi]
	Real Data 3D File Format: BCF3DPC
	Files that follow the BCF3DPC format
	Example: Real refractive index in 2D [*.rri]
	Complex Data 2D File Format: BCF2DCX
	New format
	Files that follow the BCF2DCX format
	Example: Complex field (end of propagation) in 2D [*.f2d]
	Complex Data 3D File Format: BCF3DCX
	New format
	Example: Complex field (end of propagation) in 3D [*.f3d]
	Files that follow the BCF3DCX format
	User Refractive Index Distribution File Format
	Default format for 3D Refractive Index Distribution
	Reading User Refractive Index Files
	Complex Data 3D Vectorial File Format: BCF3DCXV
	Path Monitoring File Format
	BCF2DPM
	Power In Output Waveguides File Format
	BCF2DMC


